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Government Reporting Tool

Use the Government Reporting Tool (GRT) to extract primary health care key performance indicators (nKPIs)
for indigenous people from Communicare, analyse the data and directly upload the data to the Health Data
Portal.

Since January 2019, the Government Reporting Tool (GRT) has been used to extract datafor the nKPI, OSR
and Health Care Provider (HCP) submissions from Communicare. Thistool should be used by health service
management personnel who are responsible for periodically collating, analysing and reporting on nKPI data.
The GRT uploads the extracted data to the Commonwealth Department of Health (DoH) Health Data Portal.

6 Tip: For more information about Indigenous Health Data Reporting, see IHDR User Help.

Before each submission period, Communicare Support will contact local Communicare Administrators to
ensure that the GRT is accessible and any updates to the GRT and reports are communicated.

Data can also be reviewed at any time using the following Communicare report suites:

* Report > nKPI
* Report > OSR
* Report > Health Care Providers

Communicare Administrators should run these reports regularly to check that their health service’s dataison
track before the January and July submission deadlines.

Note: For state-based reporting, NT KPI (on page 70) and NSW KPI (on page 67) reporting
suites are available in Communicare as both individual reports and aggregated summaries. Refer to
your state health departments for the correct process to submit your data.

Government Reporting Tool prerequisites

Before you run the Government Reporting Tool and upload Indigenous Health Data from Communicare to the
Health Data Portal, ensure that each of the following steps are compl eted:

1. Obtain the AIHW security data token from the Department of Health.

2. Communicare Support has enabled the data token for your site.

3. Communicare Support has set up and configured SQL Server Express for your organisation.

4. Communicare Support has installed the Government Reporting Tool on your organisation’s
Communicare server and ensured that it isworking correctly.

Government Reporting Tool overview
To ensure that your siteis ready for the reporting submission period, complete the following steps:

1. Ensure Communicare is configured in accordance with the NPKI information (on page 13) and that
staff are using the correct items.

2. Use the Communicare reports to audit biographics for missing data and ensure staff are using the
correct place and mode to record consults.
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https://bit.ly/communicarehelp

3. Run the nKPI reports (on page 33), OSR and Health Care provider reports (on page 54) reports
in Communicare to verify the state of the data and repeat steps 1-2 if required. For alist of the available
government report suitesin Communicare, see Statutory Reporting and Communicare (on page 7).

4. Ensure the Government Reporting Tool isinstalled and accessible by the Communicare Administrator
or person responsible for uploading to the Health Data Portal.

When these steps are complete, you can run the Government Reporting Tool to submit your data to the DoH
Health Data Portal.

Statutory Reporting and Communicare

There are currently four major reporting suites in Communicare for government reporting. Other program
reporting suites may exist on your database, such as PMHC, CHSP, ITC, HACC, ANFPP, APCC.

Reporting suites
Reports usually have the following parameters:

* A date range or report date where the end date is usually 30th June or 31st December. For internal
reporting this can be any date required. Where a‘from date’ is collected it may be ignored for some
indicators where the currency period is defined in the indicator.

* A locality group parameter with the option <All Locality Groups>. In most cases this last option
should be selected but where more than one organisation shares a database, or internal reporting for
separate regions is required, a specific locality group may be sel ected.

* A patient indicator that can be Al HW Regul ar Cl i ent or Cormuni care Current Patient.OSR,
nKPI and NSW reports must be uploaded with the Al HW Regul ar d i ent option selected.

The four reporting suites below essentially perform similar tasks for different agencies but differ in various
ways. Thistableisto help you understand the differences.

Table 1. Comparison of KPI reporting suites

Reporting OSR National KPI NT AHKI NSW KPI
Included in Yes Yes Yes Yes
Communicare

CS-01to PIOlto P24 AHKPI 1-01 KPI 01 to KPI 09

CS-04 to AHKPI

HP-01 Additional: 1-20

L-06 to L-07

MCH-01to i Additional:

MCH-03 it

S0610 507, identified Setup

S10to S11 atient t

& S13to parients —repor

S14 defined as to assist

SE.061 regular configuring

.07 0 Ver si on — encounter

¥ C-P specifiesthe places and
version of the locality
reports roups

Additional: & group

Epi sodes

and

Cont acts

by dinic

—may be

required
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Table 1. Comparison of KPI reporting suites (continued)

Reporting OSR National KPI NT AHKI NSW KPI
for separate
reporting
for remote
clinics
Can berunby a Yes Yes Yes Yes
non-Administrator
Can report on patient | No Yes Yes Yes
names
Each report hasa Each report shows Each report has the option
companion report patient names to include patient names or
that displays patient not
names
Single report No Yes Yes Yes
available
Summary - AHKPI  Dat a Data Sunmmary
reportson Export
any indicator AHKPI Dat a
where there Export for
is some data Sel ect ed
Cinic
AHKPI Dat a
Export
Sunmar y
Upload functionality | Communicare's Communicare's Data Export Manual dataentry - Dat a
Government Government manually uploaded | Sunmary to be printed
Reporting Tool - Reporting Tool - al |to NT portal - run and transcribed into NSW
Includes only CS-01 | indicators AHKPI Data Export |portal
to CS-03 (renamed and save output as a
as APl to AP3) and CSsV file
HP-01 (renamed as
CSP2)

Run the Government Reporting Tool

At reporting time, use the Government Reporting Tool to extract the nKPI data you need from Communicare
and submit it to the Department of Health Data Portal .

About thistask

Australian Government

Praview KPls in directony Submit previewed KPls from Department of Health
Step 1 Step 3
T Click preview KPls to Step 2 Log onto the Department of F N
: Start p{ eenerate M35 Excel v [—® Click submit KP|s to upload——® Heath portal to review the ™ Finish :I
- files with the required the KPls to the Doto porto | draft submission and change
data its status.

The overall process for extracting Indigenous Health Data from Communicare and uploading the data into the
Health Data Portal can be distilled into the following steps:
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1. Using the Government Reporting Tool, extract data from Communicare to spreadsheets which you can

review.
2. Using the Government Reporting Tool, upload the KPI data to the Health Data Portal.
3. Inthe Health Data Portal, review and confirm the submission.

Procedure
To run the Government Reporting Tool:

1. On or after 1 July of each year, double-click the Gover nment Reporting T ool application on your
Communicare server to run it.

W Government Reporting Tool 1.5.2 (1.2.1.0) HEALT.., = O o
Report end date: 31/03/2021 j
Organisation: All organisations

Graup: All groups
Refresh data Mote that this will take a long time

Documents

L}

Preview KPIs in directory

using securnty token VLTE _dlj2k

Show admunistratar information

Thetitle bar of the Government Reporting Tool displays the version of the tool, the username of the
person who is logged on and the name of the computer. Check with Communicare Support that you are
running the latest version.
2. In the Gover nment Reporting Tool window:
a. From the Report end date calendar, set the reporting date to the end of the reporting period. No
data recorded after this date isincluded in the nKPIs.
b. From the Organisation list, select the organisation for which the KPI extract will be generated
orsettoAll Organi sations.

Note: Often the Health Data Portal only accepts submissions for which Al |
Or gani sat i ons has been sdlected.

c. From the Group list, select alocality group. This determines which patients are included in the

KPI extract.
3. If you have updated the Communicare nKPI configuration as described in NPKI information (on page
13), click Refresh data. The tool retrieves datathat is new or has been updated in Communicare
since it was last run. The refresh process takes 5 - 60 minutes.

Tip: Datais automatically refreshed nightly. Click Show administrator infor mation to see
when the data was last refreshed.

Y ou can also click thislink in the following circumstances:
o You are directed to by the tool because it has detected an issue
> You have retrospectively updated historical encounters and want these historical updates
included in the nKPI reports
4. When the datais refreshed, click Preview KPIsin directory. This process takes 1-5 minutes.

(c)Telstra Health | Communicare



The directory to which the files have been saved is opened when the process is compl ete.
5. If required, manually review the CSV output files using Microsoft Excel.

0 Tip: Todisplay the filesin aformat where you can filter and sort the data:
a. In Microsoft Excel, press CTRL+A to select all data.
b. Select Insert > Table.

6. After you have reviewed the KPIs, to submit the KPIsto the Health Data Portal in draft form click
Submit previewed KPIsfrom. This process takes 1-5 minutes.

Note: Thislink is enabled only if the KPIs have been generated using an Organisation and
Locality Group that has an AIHW security token for your site.

Results

The Indigenous Health Data extracted from Communicare is uploaded to the Health Data Portal.

What to do next

Log onto the Commonwealth Department of Health (DoH) Health Data Portal and review the draft submission
and compl ete the data asset upload process. When you are satisfied with the submission, change its status.

If you encounter problems using the Government Reporting Tool:

1. Click Show administrator infor mation.
2. Copy or take a screen capture of al the content in the Show administrator information pane and
attach it to aticket for Communicare Support for resolution.

o Tip: Scroll down to view all data.

GRT output files

The Government Reporting Tool produces the following files.

system

g’ Hcepltems.csv
E‘_ NkpiCountMeasures.csv

£37] NkpiPercentageMeasurePatients.csv
0’ MkpiPercentageheasures.csv

-y
B2 OsrCountMeasures.csv

Date modified Type Size
AE PTG A58 Dk b rraenft Eveal ™ a =

NG/ 310 A28 DRA M craneaft Bxenl Co KR

Table 2. Files produced by the GRT

File

Purpose

Hcpltens. csv

A list of providers

Nkpi Count Measur es. csv

A count of the total number of clients included for each KPI

ts.csv

Nkpi Per cent ageMeasur ePat i en

The numerator, denominator and percentage for each KPI, that isthe
underlying data. Thisis equivalent to the nKPI Patients Report in
Communicare.
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GRT & nKPI Reference Guide


https://dataportal.health.gov.au/
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Table 2. Files produced by the GRT (continued)

File Purpose

Gsr Count Measur es. csv Counts for operational services

syst em Manual - HCP - Thisfileisused if it's necessary to manually upload the HCPs to the Health
O g. xnl Data Portal using the Department of Health website.

system Manual - NKPI - Thisfileisused if it's necessary to manually upload the nKPIs to the Health
O g. xm Data Portal using the Department of Health website.

system Manual - OSR - Thisfileisused if it's necessary to manually upload the OSRs to the Health
O g. xm Data Portal using the Department of Health website.

Troubleshoot the GRT

If you have a problem running the Government Reporting Tool, check here before contacting Communicare
Support

Check the following:

1. Your domain user account or group has been given access to the GRT.

2. The GRT is being passed through the correct hosthame to the SQL Server that it uses.

3. There are no security policies blocking access to TCP and UDP ports 1434 and 1433 on the SQL
Server.

4. There are no group policies preventing the GRT being run. Check with your Network System
Administrator.

5. You have access to the shared folder where the GRT isinstalled.

6. The SQL Server isrunning.

If you are still experiencing difficulties contact Communicare Support.

Manually upload nKPI filesto the Health Data Portal

Running the Government Reporting Tool automatically uploads all of the necessary datato the Health Data
Portal.

Before you begin
However, if you encounter connection errors, you can upload the xml files created by the tool to the Health
Data Portal manually.

About thistask

Note: Thisinformation isageneral guide only. For further support and help, see Indigenous Health
Data Reporting (IDHR) or call 1800 316 387 (8.30am to 5pm AEST Monday to Friday, excluding
ACT and national public holidays).

Procedure
If the automatic upload to the Health Data Portal fails, to upload the files generated by the Government
Reporting Tool manually:

1. Copy the XML files created by the Government Reporting Tool to your computer. For more
information, see GRT output files (on page 10).

2. Log into the Health Data Portal.

3. Select New > Asset for Submission.

(c)Telstra Health | Communicare
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https://dataportal.health.gov.au/wps/portal/dataportalcontent/usersupport/userhelpihdr/!ut/p/a1/nZBdb4IwFIb_ym68bHqAgnBJdImIxJGZKL0xpRTpAqVCXeZ-_UpMFm_22bs3PXnPcx5M8QFTxV7liRnZK9ZOmQZHP0kTIOCmkC0JxJHv55GfQJjO8R5TTLky2jS4qJhhuh8Max94r4xQZgbjdTSim8FlFMN40dP3LTSi1bKphqlAc1nhArygEg44KKoZR0SEDmLgCVQGpORhWTJehpaosETwxYvhV8DfNxR2xfzobBewWhPYbHfEhxxy93G5cgBcwM9_ZF7_BGWPcodskZ1sLTMNkqru8eFO2S18KrPz8uV8prF1P4l-swP_k6-7LvSuSL3v6m7_tIk_AE0RQGE!/dl5/d5/L2dBISEvZ0FBIS9nQSEh/
https://dataportal.health.gov.au/wps/portal/dataportalcontent/usersupport/userhelpihdr/!ut/p/a1/nZBdb4IwFIb_ym68bHqAgnBJdImIxJGZKL0xpRTpAqVCXeZ-_UpMFm_22bs3PXnPcx5M8QFTxV7liRnZK9ZOmQZHP0kTIOCmkC0JxJHv55GfQJjO8R5TTLky2jS4qJhhuh8Max94r4xQZgbjdTSim8FlFMN40dP3LTSi1bKphqlAc1nhArygEg44KKoZR0SEDmLgCVQGpORhWTJehpaosETwxYvhV8DfNxR2xfzobBewWhPYbHfEhxxy93G5cgBcwM9_ZF7_BGWPcodskZ1sLTMNkqru8eFO2S18KrPz8uV8prF1P4l-swP_k6-7LvSuSL3v6m7_tIk_AE0RQGE!/dl5/d5/L2dBISEvZ0FBIS9nQSEh/

| DATA [PORTAL

Status & Data Period &

Dt Submission H0Deci2018 to 20 Dwci2018
Submission Approved 19 Tec2018 to 19 Dec 2018
Depht Submission 1M 2018 bo 21 New 018

2 Assets for Indigenous Health > niKPl

Tithe &
Communicare Test Manual Fie
Communicare Test Submission

last

4. In the New Draft Submission window, add information to all required fields:

4.
Mrdhﬂwtnm
Deparimsent of Mealih

'« B

New Draft Submission

'DATA PORTAL

Asset Details * Wandiatory feid
Tithe * CC TestFile
Description o

Submitted by
Organisation
Date Submined

Foldar *
[This determines who in Healih
feceives the submission)

Reponing Round

Data Period

Files
Fibe Hame

Mo Sles hived bian 303ed yol

Cancel

497 charachers remaining

Feldr* InigIncUs Healm

Sub-Folder AKP

Agasonal info

Reporing Paniod Triad Submission

Duata Penod Trial Submisshon

St 0UDec2018 End  1lan2019
Last Moditied Description

B Create nKPI Form

a IntheTitlefield, add atitle.
b. From the Folder list, select the required folder. For example, | ndi genous Heal t h.
c. Inthe Data Period fields, enter the reporting period.
d. If required, click Create nKPI Form.
e. Click Add File and upload the xml file from your computer.

f. Click Save.
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Key Performance Indicators

Health service management personnel can collate, analyse and report on National Key Performance Indicators
and state-based Key Performance Indicators using Communicare.

}’ Note: Y ou can make National Key Performance Indicator (nKPl), Online Services Reports (OSR)
and Hesalth Care Provider (HCP) submissions from Communicare, using the Government Reporting
Tool (on page 6).

Data can also be reviewed at any time using the following Communicare report suites:

* Report > nKPI
* Report > OSR
* Report > Health Care Providers

For state-based reports:

* In New South Wales, run the reportsin Report > NSW KPI.
* In the Northern Territory, run the reportsin Report > NT KPI. For more information, see NT KPIs (on

page 70).

Data requirements

To use Communicare for reporting on Key Performance Indicators, the following data requirements must be
met:

» Conditions are coded using the central |CPC2-Plus dataset

* Prescriptions are recorded using the prescribing module which relies on the MIM S Pharmaceutical
database

» Medicare claims are bulk-billed and use the Communicare el ectronic claims module

« Pathology results are delivered electronically using HL 7 results with appropriate coding returned by the
lab

» Common qualifiers that may be recorded as point of care testing or transcribed results, for example,
from a hospital discharge document, use the central qualifiers. If your health service departs from
the central dataset (for example, to record an ACR or GFR) it is your responsibility to transcribe the
associated system code or export code if the concept remains the same. For reference qualifiers, such as
smoking status, attention must be made to each reference’ s system and export code.

» For state-based reporting, the health service is already configured for National KPI reporting and needs
only to consider state indicators that have no nKPI equivalent. Wherever possible, given the definitions,
data collection requirements are common across the KPI reports.

National Key Performance Indicators

Use thisinformation to assist with the Indigenous primary health care key performance indicators (nKPI) and
On-line Services Report (OSR) reporting within Communicare.

This document outlines the way in which information recorded in Communicare isidentified for each
indicator.

(c)Telstra Health | Communicare 13



Thiswill alow health servicesto advise users on how best to ensure the most accurate recording of datafor
the National Key Performance indicators (NKPI) and On-line Services Report (OSR) reports.

Demographics overview

Only those patients who meet the required Indigenous status, record status, patient status, age, or address are
included in the reporting.

Indigenous status

National Key Performance Indicator reporting almost exclusively reports on patients who are recorded
as being Indigenous. In Communicare this means that they have an Indigenous Status recorded in their
biographics of one of the following:

* Aboriginal but not Torres Strait |slander
*Torres Strait |slander but not Aboriginal
*Both Aboriginal and Torres Strait |slander

Any exceptions are stated in the definition for that specific indicator.

OSR reporting is disaggregated by Indigenous Status. In these reports the following mapping is done:

*Aboriginal & Torres Strait Islander -includesall patients with one of the above statuses
recorded in their biographics.

* Non- Abor i gi nal - any patient with an Indigenous Status of Nei t her Abori gi nal nor Torres
Strait

* Not Recor ded - any patient where the Indigenous Status is not recorded, or the Indigenous Statusis
Not stated/inadequately described or Not applicable.

Note: For OSR reporting, fictitious patients are excluded. Patients who died before the end of the
reporting period are counted if they had any activity during the report period. Non-patient records are
included to record group activity and contacts made with patients who do not normally attend this
health service. For the purposes of disaggregation by Indigenous Status, all non-patients are recorded
asNot Recorded.

Record status

For the AIHW definition of a Regular Client this status is determined by looking at the contacts made with a
patient in the two years preceding the end of the report period. In Communicare, a patient's status must be one
of the following:

* Current

* Transi ent

* Past

* Banned 30 days
* Banned 60 days

Patients who have a Communicare patient status of Fi cti ti ous (either at the time the report is run or at the
end of the report period) are excluded. Patients who had a Communicare patient status of Non- Pat i ent at
the end of the report period are also excluded.

Only servicesthat have started are included: services with a status of St art ed, Paused or Fi ni shed are
included. Services with the following statuses are excluded:

14 GRT & nKPI Reference Guide



* Booked

e Cancel | ed
* VWi ting

* Wt hdrawn

Additionally, services with the following modes are excluded:

* Allno client contact modes
e Adm nistration — client contact

If apatient has at |east three such services in the two years preceding the end of the report period and they
were gtill alive at the end of the report period, then they are deemed to be aregular client. However, see the
comments in the Residence section below relating to the patient’ s home address at the end of the report period
and how thisrelatesto use of the Locality Group parameter in Communicare reports.

OSR reporting does not use the Regular Client status. All patient records are included except Fictitious patient
records. Non-patient records are included but reported with an Indigenous Status of Not Recor ded.

Patient status

For nKPI reporting, al patients with a status of Non- Pat i ent are excluded even if they have three visitsin
the previous two years.

For OSR reporting, the Non- Pat i ent statusistreated in the following way:

« If the patient record has an MRN of #GROUP, group activity will be counted but not in the contacts,
episodes or individuals reports.

« If the patient record has an MRN of #ANON, any activity is disregarded. This means that the patient
record is for anonymous activity and any age, sex or Indigenous status will be unknown so the data
cannot be disaggregated.

« If the patient record does not have an MRN of either #ANON or #GROUP, activity will also be
disregarded.

To assist in the identification of any existing Non-Patient records where the addition of either #ANON
or #GROUP is needed, refer to the report at Report > OSR > Non-Patient Analysis. This report should
eventually report three main sections (if anonymous or group activity is recorded at the health service):

* Group activity record: an exampleis UNIDENTIFIED CLIENTS. If the patient ID has an asterisk, this
is currently being used for group activity.

» Anonymous patient record: examples might be NEEDLE EXCHANGE, MALE or WALKIN,
UNKNOWN.

+ Other non-patient records. these should all be real people but who only attend the health service
for specific purposes other than their main health care, such as, dental only patients or ITC patients
referred from a private GP for supplementary services. If they should be included in the nKPI reports
and the OSR reports, their status must be changed from non-patient.

0 Tip:

Only usethe Non- Pat i ent status for the following reasons:

» To record biographic details of a carer who is responsible for a patient of the health service but
who does not attend for their own health care

» Torecord areal patient who may attend the health service for a single purpose, such asa
dental clinic, but who belongs to ancther health service and does not require any other health
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0 service delivery, such as health check reminders, blood tests, chronic disease management, and
SO on.
* To record anonymous services such as group information sessions, anonymous needle
exchange, health promotion events, and so on.

Residence

A patient must have had a home address at the end of the report period. What this meansis that a patient
added after the end of the report period will not be included even if they have backdated service activity.

When the Locality Group filter is used for any of the Communicare reports the patient list isfiltered to those
patients whose home address locality at the end of the report period was within the defined list of localities
that make up that locality group. It isimportant that the locality groups defined at the health service are
accurate and inclusive. To help you review your locality groups run the following reports:

» Toprint alist of all localities within all locality groups, run Report > Reference Tables > L ocality
Groups. Maintenance to these listsis done at File > Reference Tables > L ocality Groups.
* To look for omissions and mistakes, run Report > Reference Tables > Locality Group Analysis.

Tip: Run this report with arange of post codes that covers your health service area

completely.
First post code bo inchuds ||:ra,7|:|
Laak post code o inchude ||:|3,72
Siste Ll =)
Inchade Unissed Localibes N - |

The resulting report will show al locality groups and indicate which localities belong to multiple or no
such groups. Maintenance to these listsis done at File > Reference Tables > L ocality Groups.

Agegroups
The default nKPI age groups are:

* 0-4 years

* 5-14 years
» 15-24 years
» 25-34 years
» 35-44 years
» 45-54 years
* 55-64 years
* 65+ years

Where stated in a specific indicator these may vary. For example, child immunisation age groups differ as do
antenatal care age groups.

Ageiscaculated at the end of the report period (unless a specific indicator states otherwise). Patients who
died during the preceding two years but who have had three valid services recorded will be excluded.
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Contact types

OSR reporting requires disaggregation of provider types when reporting on contacts. In Communicare, a
provider typeisin recorded in Communicare in the Provider reference table: in File > Providers, select the
provider type from the Speciality list.

Sumame |E E:on
Quakficafions B
Speciality r dical Prachion
peescaber e Exsrcise: Physiologet -
Ee Health Coondinabor
Jﬂ (5 s troenbeobogist
General Medical Practitione:
Genstician
Gynaecologeal Oncologet
Heakh Disgrocsis/Teestment Praciione |«

For information about how the Communicare speciality is mapped to the OSR contacts report, see Client
Contact Types reference (on page 28)

Note: Services provided exclusively by a Transport Worker (as recorded in Communicarein the
Provider reference table) are excluded from the OSR Episodes of Health Care report.

|dentifying data required for nKPI reporting

The nKPI reports extract data from clinical itemsin patient records and Medicare claims.

Conditions

Many of the performance indicators depend on recognising patients because of a documented condition. This
is done by referencing | CPC codes attached to the Communicare condition clinical items.

System administrators can review | CPC codes.

To review codes for a single condition:

1. Select File> Reference Tables > Clinical Item Types.
2. Inthe Clinical Item Type Maintenance window, double-click an item and click Advanced.

The ICPC code and term are listed in the | CPC 2 Plus section.

ICPC 2 Plus c Other
Code D Tem |002 Stahss Ackive

Toreview al items with the same or similar codes;
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1. Inthe Clinical Item Type Maintenance window, right-click and select Show Hidden Columns.
2. Scroll to the right to find the | CPC Code column and click the header to order by |CPC code.

Type Mo= |[lcscm:ﬂ.lon._ |ﬂass-‘ ITI:-;-:._ ||-|:PCCO-:I:} |||:|""C Tem
2000003640 | Disbetes ron neulin depend | Condition Endoctine, ... | T30 L1
2000003717 Diabetes adult orgel Condition Endocrine, ... T30 o7
2000003719 Diabetes:Typs 2 Condition Endocrine, .. T30 11}
2000008342 Diabetes.Type 2ansulin bie.. | Condition Endocrine, .. | TS0 1313
2000009539 Hyperghycaemes [disbetic]  Condition Endocring, ... T30 mng
2000002696 Beri Beri Condition Endoctine, ... TH o
2000004044 | Dehciency nutritional Condition Endocrine, ... TH 2
2000004051 Dishciencywitamir Candition Endocrine, .. T 03

6 Tip: To move acolumn, click and drag the header.

Conditions are recorded in Communicare by adding a clinical item of type Condi t i on to the patient. For
chronic conditions the date of diagnosisis disregarded. For some conditions, if specified, the date of diagnosis
will be required to be within the report period.

Note: Conditions added to a patient record have no status other than Conpl et e, so all such items are
considered to be confirmed. Any informal comment that may indicate that the condition is not yet
confirmed are disregarded.

For details of which ICPC codes are referenced for specific indicators, check the indicator.

Procedures and immunisations

Because health services may have configured local ways of documenting specific procedures and
immunisations, the reports will often look for a system code or, more often, an export code. Review codesin
the same way as |CPC codes (on page 17).

Because both procedures and immunisations can have a status of Recal | , Cancel | ed, | nconpl et e or
Conpl et e theindicator will consider the status. In most cases the status must be Conpl et e in order to be
counted, but for some indicators, such as P104 (immunised children), recalls are considered as well. See each
indicator for details.

System codes

Three-character system codes are often used within Communicare to identify clinical itemsto the
Communicare program but are also used for identifying items for reporting. For example, AHC is used to
identify annual adult Aboriginal health checks.

Note: No local items should have system codes unless they have been verified as suitable and
correctly identify the item.

To review system codes:

1. Select Report > Reference Tables > System Codes and Rule Codes.
2. Toreview local items, use the following settings:

o Fromthe Item or qualifier list, select i nical |tens.

o From the Item or qualifier list, select Local Only.
3. Toreview central items, use the following settings:
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o From the Item or qualifier list, selectd i nical |tens.
o From the Item or qualifier list, select Central Only. To review both local and central items,
salect <Al | >.

For details of which system codes are referenced for specific indicators, check the indicator.

Export codes

Export codes are used exclusively for reporting. They can be up to eight charactersin length. For example,
CST is used to identify procedures that are evidence of acervical screening or equivalent having been
performed.

For immunisations, the codes used as export codes are the AIR immunisation codes. For example, VAXGRP
identifies an adult Vaxigrip immunisation when reporting on influenza immunisations.

Review codesin the same way as | CPC codes (on page 17) or run Report > Reference Tables > System
Codes and Rule Codes

For details of which system codes are referenced for specific indicators, check the indicator.

Qualifier codes

Quadlifiers are attached to clinical items, and are used in Communicare to capture detailed data relating to such
things as blood pressures, HbA 1cs, ACRs, eGFRS, and so on. Because qualifiers can also be locally defined,
we use system codes and export codes to formally identify them for reporting purposes. For example, an

HbA 1c recorded as percent has a system code of HBA; for HbA 1cs recorded in mmol/mol, a system code of
HBMis used.

Note: Local qualifiers must be are reviewed for both system and export codes.

To review codes for asingle qudifier:

1. Select File > Reference Tables > Qualifier Types.
2. Inthe Qualifier Type Maintenance window, double-click an item.

The system codeislisted in the System Code field.

To review all system and export codes, in the Qualifier Type Maintenance window, right-click and select
Show Hidden Columns.

T Qualifier Type Maintenance
- A4 e o o= Locate: |

[ Mumber [Duﬂlﬁ Dessorphion I'U'ahc Type [Urds IE—j.l:re-m Code IE spoit Code [

|_ 10000007119 | Hb [Hasmcglobin) Humaric all HEH 1528
V000001349 | Hed e Humeric ol freecd HEM
1000000054 HEdte %) M s b4 HEA
1000000 HCH Tier Astassrrsnt [HARF] D ropsdowrn kst Fafaancs HARFHCH

|- 1000000051 | HOL lewvel Humernc mimolfL HDL

To generate areport of qualifier system codes:

1. Select Report > Reference Tables> > System Codes and Rule Codes.
2. Toreview local qualifier codes, use the following settings:

> From the Item or qualifier list, select Qual i fiers Itens.

o From the Item or qualifier list, select Local Only.
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Medicare clams

Where an indicator refers to evidence of aMedicare claim for a specific item or items, the datais collected on
the patient encounter, often referred to in Communicare as a service.

For inclusion in both nKPI and OSR reporting, the claim has only to be selected to be included. The following
statuses are included:

* Sel ected

* Sent

* Accept ed (which isinterpreted as paid)
* Rej ected

Claims that have been discarded by the local claims administrator are excluded from reporting. Claims can be
discarded only following rejection by Medicare.

To assess if a patient has a specific item claimed within a specific time period:

 Intheclinical record, click ===Claims.

* In the Service Record window, on the M edicar e tab, click ===MBS Items History.

Condition codes reference
Find the active ICPC-2 PLUS condition codes for NKPI reporting here.
Diabetes

A patient is recognised as having Type Il diabetesif they have a condition recorded with the ICPC code of
T90. The date of diagnosisis disregarded.

As of December 2021, the active ICPC2-Plus terms for Type |1 diabetes used for nKPI reporting are:

Table 3. Diabetes included terms

Condition subgroup Code Clinical term
TYPE 2 DIABETES T90005 Diabetes non insulin depend
T90007 Diabetes adult onset
T90009 Diabetes Type 2
T90016 Diabetes Type 2 insulin treated
UNSPECIFIED DIABETES T90002 Diabetes mellitus

To find all terms, use Report > Reference Tables > Clinical Item Groups. Use the following parameters:

* Clinical Itemor Group-<All Cinical Items and G oups>
* |CPC Code - T90

COPD

COPD diagnoses are recognised from the |CPC code of R95 or R79. As of December 2021, the active | CPC2-
Plus terms used for nKPI reporting are:
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Table 4. COPD included terms

Condition subgroup Code Clinical term

CHRONIC BRONCHITIS R79002 Bronchiolitis chronic
R79003 Bronchitis chronic

COPD R95001 Chronic obstr airways disease
R95002 Chronic obstr pulmon disease
R95004 Chronic obstr lung disease
R95008 Chronic airways limitation
R95009 Chronic airways disease

EMPHY SEMA R95006 Emphysema

Tofind all terms, use Report > Reference Tables > Clinical 1tem Groups. Use the following parameters:

* Clinical Itemor Group-<All Cinical Items and G oups>
* |CPC Code - R95 or R79

CKD

Chronic Kidney Disease diagnoses are recognised from the following ICPC and | CPC2-Plus codes: U99, U88,
U85001.

As of December 2021, the active ICPC2-Plus terms used for nKPI reporting are listed below.

Table 5. CKD included terms

Condition subgroup Code Clinical term

CKD 3 U99037 Chronic kidney disease stage 3
U99037 Disease kidney chronic stage 3
U99043 Disease kidney chronic stage 3A
u99044 Disease kidney chronic stage 3B

CKD 4 U99038 Chronic kidney disease stage 4
U99038 Disease kidney chronic stage 4

CKD 5 U99039 Chronic kidney disease stage 5
U99039 Disease kidney chronic stage 5

DIALYSIS U59001 Dialysis;kidney (renal)
U59008 Haemodialysis

Kidney transplant U28001 Renal transplant

CvD

Cardiovascul ar disease diagnoses are recognised from the following | CPC and | CPC2-Plus codes: K89,
K90, K91, K92, K74, K75, K76, K52008, K53003, K53007, K53009, K53010, K54007, K91011, K91014,
U99028.

As of December 2021, the active |CPC2-Plus terms used for nKPI reporting are listed below.
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Table 6. CVD included terms

Condition subgroup Code Clinical term
ACUTE CORONARY SYNDROME | K74001 Angina pectoris
(ACS)/ANGINA K74002 Pain angina

K74004 Unstable angina

K74006 Insufficiency coronary

K74007 IHD with angina

K74008 Acute coronary syndrome

K74008 Acute coronary syndrome
CAROTID ARTERY STENOSIS K91014 Stenosis artery carotid

K91014 Stenosis, artery, carotid

K91016 Disease carotid

CEREBROVASCULAR DISEASE

Code unavailable

Lacunar stroke

Code unavailable

Migrainous stroke

K22

Personal history of cardiovascular disease
(Risk factor for CVD incl)

K 89008 Insufficiency vertebrobasilar
K89011 Insufficiency cerebrovascular
K90002 Cerebrovascular accident
K90004 Haemorrhage;subarachnoid
K 90006 Haemorrhage cerebral
K90010 Infarction cerebral

K90011 Occlusion cerebral

K90012 Paralysis poststroke/CV A
K90017 Stroke

K90018 Thrombosis artery cerebral
K90018 Thrombosis,artery;cerebral
K90020 Embolism;cerebral

K90025 Paresis poststroke/CVA

K 90026 Hemiparesis post stroke/CVA
K 91006 Disease cerebrovascular
K91007 Cerebral artery aneurysm
K91008 Occlusion precerebral
K91009 | schaemia cerebral

K91010 Stroke/cvaold

K91011 Stenosis arterial precerebral
K91012 Thrombosis artery precerebral
K91013 Embolism;precerebral
K91014 Stenosis,artery;carotid
K91015 Atherosclerosis cerebral
K92018 Embolism, arterial
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Table 6. CVD included terms (continued)

Condition subgroup Code Clinical term
CEREBROVASCULAR DISEASE - | K89001 Transient ischaemic attack
TIA K89004 Vertebral artery syndrome

K 89005 Basilar artery syndrome

K 89008 Insufficiency basilar

K89015 RIND syndrome
CORONARY HEART DISEASE K 74006 Insufficiency coronary

K74007 IHD with angina

K75004 Occlusion coronary

K75008 Thrombosis artery coronary

K 76005 Disease atherosclerotic heart

K76008 I schaemia myocardial chronic

K76011 Disease ischaem heart subacute

K76013 Coronary artery disease

K76013 Coronary heart disease

K76014 Disease ischaemic heart

K76015 Disease ischaem heart chronic

K76018 IHD without angina

K76019 Atherosclerosis coronary

K 92007 Occlusion arterial

K92022 Stenosis artery

K92024 Atherosclerosis

K92025 Arteriosclerosis

K92028 Insufficiency vascular

K 92030 Atherosclerosis aorta

K92031 Disease small vessel

K75009 Embolism artery coronary
MY OCARDIAL INFARCTION K75001 Infarction heart

K75002 Infarction myocardial acute

K75010 Infarction impending

K75011 Postmyocardial infarct syndrome

K75013 Infarction myocardial

K75014 Heart attack

K75015 Myocardial infarction STEMI

K75016 Myocardial infarction non STEMI

K 76006 Infarction myocardial healed

K 76006 Infarction myocardial old
PERIPHERAL VASCULAR Code unavailable Arteriosclerosis obliterans
DISEASE (PVD) K92003 Disease peripheral vascular
RENAL ARTERY STENOSIS Code unavailable Stenosis artery renal
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Table 6. CVD included terms (continued)

Condition subgroup Code Clinical term
SURGERY - CARDIOVASCULAR - | K52008 Endarterectomy internal carotid
CAROTID K53007 Stent(s) carotid

K91016 Disease carotid
SURGERY - CARDIOVASCULAR - | K53003 Angioplasty;artery;coronary
CORONARY K53009 Stent(s)coronary

K54007 Graft coronary artery bypass
SURGERY - CARDIOVASCULAR - | U99028 Renal artery stenosis - Stent
RENAL ARTERY

Procedure, Immunisation, Pathology & Medicare codes reference

Find the active ICPC-2 PLUS Procedure, |mmunisation, Pathology and Medicare codes for NKPI reporting
here.

Annual Health Assessments

Currently (February 2018) annual health assessments are only referenced in nKPIs by the associated Medicare
claim (715, 228, 92004, 92016, 92011, 92023).

For OSR reporting the following System Codes are referenced on clinical items only whenever a patient has
no claim for Medicare item 715 (or 228, 92004, 92016, 92011, 92023):

» AHC for adult annual health checks
» CHC for child annual health checks
» OHC for over-55s annua health checks

CarePlans

Currently (February 2018) care plans are only referenced in nKPIs by the associated Medicare claim (721 721,
229, 92024, 92068, 92055, 92099).

* The System Code used to identify care plan assessmentsis CPA.
* The System Code used to identify Team Care Arrangementsis TCA.

Pregnancy and Cervical Screening Items
These Rule Codes are referenced:
* PR- CHECK — any procedure identified by this rule code will be deemed to be an antenatal check. By
checking the pregnancy number and then looking for an explicit gestation or by comparing with the
pregnancy outcome, the trimester in which the first antenatal check was performed can be calcul ated.

These Export Codes are referenced:

* CST, HPV, LBC - any procedure that is evidence that a cervical screening test, human papillomavirus or
liquid based cytology has been performed.
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Substance Use (Drug and Alcohol) Items

These Export Codes are referenced:

* DA- ENROL —identifies aformal enrolment to a course of drug and alcohol treatment. If this clinical
item has a reference qualifier with an export code of ‘DA-TDS' where areference with an export code
of 2 has been recorded then the treatment is deemed to be residential.

* DA- EXI T —formally marks the end of a period of drug and alcohol treatment.

» DR- ENROL —identifies the start of a period of respite for patients receiving drug and alcohol treatment.

* DR- EXI T - formally marks the end of a period of respite.

* DA- SUCS —identifies an occasion of sobering up during an overnight stay

| mmunisations

Influenza immunisations are recognised using the Export Codes on clinical items of type

I mruni sati on; brand code for the GNFLU vaccine and its equivalents, described in Equivalent and
partial equivalent vaccinestable - GNFLU entry. For example, GNFLU, PANVAX, FLUVAX, and so on.
These vaccines may change annually.

Note: COVID-19 vaccines, such as Pfizer Comirnaty and AstraZeneca Vaxzevria, arelisted in
the Non-standard vaccines and Equivalent and partial equivalent vaccines tables. For example,
ASTCOV, BHACOV, COMIRN, COVAST, GAMSPU, MODERN, NOVNUV, SINCOR.

For customers using the Immunisation V accines dataset, example codes include:

e Immunisation;flu, GNFLU

« Immunisation;influenza, GNFLU

* Immunisation;Afluria Quad, AFLR

* Immunisation;Agrippal, AGRPAL

* Immunisation;Flucelvax Quad, FCELQD

* Immunisation;Fluzone High-Dose Quad, FLHDQD
* [mmunisation;Fluarix, FLRIX

e |mmunisation;Fluad, FLUAD

* Immunisation;Fluzone High-Dose, FLUHID

* Immunisation;Fluad Quad, FLUQAD

e [mmunisation;Fluarix Tetra, FLUTET

* Immunisation;bioCSL Fluvax, FLUVAX

« Immunisation;Fluvirin, FLVRN

* Immunisation;FluQuadri Junior, FQDJN

* Immunisation;FluQuadri, FQUAD

» [mmunisation; Fluvax Junior, FVXJNR

e Immunisation;Influvac Tetra, INFLTA

« |mmunisation; I nfluvac, INFLUV

* Immunisation;Panvax (H1N1 I nfluenza), PANVAX
* Immunisation;Panvax (H1N1) 0.25ml, PANVAX
» Immunisation;Panvax (H1N1) 0.5ml, PANVAX
* Immunisation;Vaxigrip, VAXGRP

» Immunisation;Vaxigrip Tetra, VAXTET

» Immunisation;Vaxigrip Junior, VGRJINR
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| mmunisation Reviews

Immunisation reviews must be named as indicated here (case insensitive):

« Starts with REVIEW;IMMUNISATION;6 MONTH
 Starts with REVIEW;IMMUNISATION;12 MONTH
* Starts with REVIEW;IMMUNISATION;18 MONTH
» Starts with REVIEW;IMMUNISATION;4 YEAR

Export codes were introduced for June 2018 reporting and are included here for health services who wish to
name their immunisation review items differently:

* IMRV-BIR REVIEW;IMMUNISATION;BIRTH

* IMRV-02M REVIEW;IMMUNISATION;2 MONTH
* IMRV-04M REVIEW;IMMUNISATION;4 MONTH
* IMRV-06M REVIEW;IMMUNISATION;6 MONTH
* IMRV-12M REVIEW;IMMUNISATION;12 MONTH
* IMRV-18M REVIEW;IMMUNISATION;18 MONTH
* IMRV-04Y REVIEW;IMMUNISATION;4 YEAR

* IMRV-12Y REVIEW;IMMUNISATION;12 YEAR

* IMRV-50Y REVIEW;IMMUNISATION;50 YEAR

Group Activity

For OSR group activity recording the following export codes are recognised as group activity:

* HP-GRPT will be resolved as "Tobacco use treatment/prevention groups.
* HP-GRPA will be resolved as 'Alcohol misuse treatment/prevention grps.
* HP-GRPP will beresolved as 'Physical activity/healthy wt activities.

» HP-GRPC will be resolved as 'Chronic disease client support groups.

* HP-GRPL will be resolved as 'Living skills groups.

* HP-GRPU will be resolved as 'Cultural groups.

* HP-GRPM will be resolved as'Men's groups.

* HP-GRPW will be resolved as "Women's groups.

* HP-GRPY will be resolved as"Y outh groups.

* HP-GRP will be resolved as the name of the clinical item.

These additional codes are used for the maternal and child health group activities:

* MCH-GRPA will be resolved as'Antenatal groups.

* MCH-GRPM will be resolved as 'Maternal and baby/child health groups.
* MCH-GRPP will be resolved as 'Parenting and parenting skills groups.

* MCH-GRP will be resolved as the name of the clinical item.

Pathology
For some indicators, reference is made to pathology requests or results recorded in a patient record. For

example, cervical screenings can be identified by the recording of aclinical item or aqualifier but aso by the
recording of atest request or the receiving of atest result.

Test Requests

Cervical screening: Request terms with the keywords of CST, HPV, or LBC will be recognised as requests for
cervical screening test, human papillomavirus or liquid based cytology.
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Review your request term keywords at File > Reference Tables > I nvestigations > I nvestigation K eywor ds.

To print out alist, run the report at Report > Reference Tables > I nvestigation Keywor ds.

Test Results

For cervical screening, results are recognised if the name of the test returned by the lab includes any of the
following strings of text (all case insensitive):

- CST

- HPV

-LBC

« CERVICAL SCREEN

- GYNAECOLOGICAL CYTOLOGY
- NCSP

Medicare Claims

The following Medicare claim numbers are referred to in the nKPI indicators:

* 715 (228, 92004, 92016, 92011, 92023): [nKPI, OSR] Annual health assessments for Indigenous
patients.

* 721 (229, 92024, 92068, 92055, 92099): [nKPI, OSR] GP management plans

+ 10986: [OSR only] Headlthy Kids Check performed by nurse or Aboriginal Health Practitioner.

Note: This Medicare item was made inactive on 1st November 2015 but the indicator still
references thisitem.

Health CareHome Trial

Enrolment in the Health Care Home Trial is managed using clinical items with these codes:

* HC-ENROL - this should be the rule code and export code for the enrolment item
* HC-EXIT —this should be the rule code and export code for the exit item

Qualifiersreference
Find the active ICPC-2 PLUSqualifier codes for NKPI reporting here.

Numeric qualifiers

These System Codes are referenced in each specific indicator but are reproduced here for general reference:

* BPS - Systolic blood pressure measured in mmHg

* BPD - Diastolic blood pressure measured in mmHg

* WKG — Patient weight in kg

* HCM — Patient height in cm

* BMI — Patient BMI

* HBH —HbA1cin %

* HBM — HbA1c in mmol/mol

* ACR - Albumin creatinine ratio

* GFE — eGFR (estimated glomerular filtration rate) in mL/min/1.73m2
* CHO — Total cholesterol level in mmol/L
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* HDL —HDL level in mmol/L

* CHR —Tota cholesterol level/HDL ratio

» GSA — Gestational age at birth in weeks recorded in the baby’ s record)
» GST — Gestation in weeks (recorded in the mother’ s record)

These Export Codes are referenced:

* AUDITC — Alcohol audit C score

* AAQ99 — Full acohol audit score

* CVR-NO5F - Framingham cardiovascular risk recorded in %
* CVR-NO5C — CARPA cardiovascular risk recorded in %

Reference qualifiers

These System Codes are referenced in each specific indicator but are reproduced here for general reference:

* SMO— Smoking Status where the dropdown references have a system code of S, N, or E (smoker, non-
smoker and ex-smoker). Note that for local qualifiers a system code of U may be used if thereisan
option that does not define any of the three categories— it will be reported as ‘ Undefined'.

* S\VP — Smoking during pregnancy where the dropdown references have asystem code of S, N, or E
(smoker, non-smoker and ex-smoker). Note that for local qualifiers a system code of U may be used if
there is an option that does not define any of the three categories — it will be reported as * Undefined'.

* ALC— Alcohal consumption where the dropdown references have a system code of D, N, or E (drinker,
non- drinker and ex- drinker).

* ALP — Alcohal during pregnancy where the dropdown references have a system code of D, N, or E
(drinker, non-drinker and ex-drinker).

These Export Codes are referenced:

* DA- TDS — Treatment delivery setting (for residential drug and alcohol treatment)

* AAQD1 — Alcohol audit question 1 - "How often do you have a drink containing alcohol?'. The export
code of the dropdown reference is the alocated score.

* AAQD2 - Alcohol audit question 2 - "How many drinks containing alcohol do you have on atypical day
when you are drinking?'. The export code of the dropdown reference is the allocated score.

* CVR- RO5F - cardiovascular risk recorded as a reference qualifier where the dropdown references have a
system code of H, M, L or U (high, moderate, low and unknown).

* CVR- RO5C - cardiovascular risk recorded as a reference qualifier where the dropdown references have a
system code of H, M, L or U (high, moderate, low and unknown).

Miscellaneous qualifiers

These Export Codes are referenced in each specific indicator:
» CST, HPV, LBC - Any Yes/No or checkbox qualifier with this export code is deemed to be evidence

of acervical screening test, human papillomavirus or liquid based cytology if the valueis True (i.e. the
response is Yes or the qualifier is selected).

Client Contact Types reference
Each Communicare speciality type is mapped to areporting category provided by AIHW.

OSR Provider Type mapping

Communicare specialty workers are shown in uppercase below.
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Table 7. Communicare to AIHW provider type mapping

Communicar e Speciality

AIHW provider type

*« ABORIGINAL AND TORRES STRAIT
ISLANDER FAMILY HEALTH WORKER

* ABORIGINAL AND TORRES STRAIT
ISLANDER HEALTH WORKER

Aboriginal and Torres Strait Islander Health Worker
(ATSIHW)

ABORIGINAL AND TORRES STRAIT ISLANDER
HEALTH PRACTITIONER

Aboriginal and Torres Strait Islander Health Worker
Practitioner

* ABORIGINAL AND TORRES STRAIT
ISLANDER LIAISON OFFICER

*« ABORIGINAL COMMUNITY SUPPORT
WORKER

* AMBULANCE OFFICER

* ASSISTANT IN NURSING

* CHILD CARE WORKER

* CHRONIC CARE COORDINATOR

* CLINICAL ALLERGIST

* COMMUNITY / FAMILY REPRESENTATIVE

« COMMUNITY SERVICES WORKER

* EPIDEMIOLOGIST

* HEALTH INFORMATION MANAGER

* HEALTH PRACTICE MANAGER

* HEALTH PROMOTION OFFICER

* HOME HELP WORKER

* HOSPITAL SCIENTIST

* INTERPRETER/TRANSLATOR

* MEALS/FOOD SERVICES WORKER

* MEDICAL INTERN

« MEDICAL PRACTITIONER IN TRAINING

- MEDICAL RECEPTIONIST

* OTHER PROFESSION/DISCIPLINE

* PHARMACY TECHNICIAN

* PHLEBOTOMIST

* PHYSICIAN'S ASSISTANT

* RECREATION WORKER

* REGISTERED PARAMEDIC

« RESIDENT MEDICAL OFFICER

* RESIDENT MEDICAL OFFICER

* SONOGRAPHER

* TECHNICIAN

* THERAPIST'SASSISTANT

* THERAPY AIDE

* VOLUNTARY WORKER

Other health / clinical staff

« ABORIGINAL AND TORRES STRAIT
ISLANDER MENTAL HEALTH WORKER

- EMOTIONAL AND SOCIAL WELLBEING
STAFF

« PSYCHOTHERAPIST

« TEAM. PSYCHOGERIATRIC ASSESS TEAM
(PGAT)

+ YOUTH WORKER

Social and Emotional Well Being staff | SEWB staff other
or not specified

* ACUPUNCTURIST

* ALLIED HEALTH AIDE

* ALTERNATIVE THERAPIST

« ASTHMA EDUCATOR

« ATTENDANT CARER

* CARDIAC EDUCATOR

* CHIROPRACTOR

* CHRONIC CARE COORDINATOR
« COMMUNITY PARAMEDICAL

« DERMAL CLINICIAN

* DISABILITY SERVICESWORKER

Allied Health Professional | Allied health other or not
specified

(c)Telstra Health | Communicare
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Table 7. Communicare to AIHW provider type mapping (continued)

Communicar e Speciality

AIHW provider type

« ENVIRONMENTAL HEALTH OFFICER

« EXERCISE PHY SIOLOGIST

« EYE HEALTH COORDINATOR

« HEALTH DIAGNOSIS/TREATMENT
PRACTITIONER

« HOME CARE WORKER

« HOMOEOPATH

« MASSAGE THERAPIST

« MUSIC THERAPIST

« NATURAL THERAPY PROFESSIONAL

« NATUROPATH

« OCCUPATIONAL THERAPIST

« ORTHOTIC PROSTHETIST

« ORTHOTIST

« OSTEOPATH

« PERSONAL CARE ASSISTANT

« PHYSIOLOGIST

« REHABILITATION AIDE

« SPEECH PATHOLOGIST

« SPEECH THERAPIST

« TEAM. AGED CARE ASSESSMENT TEAM
(ACAT)

« TEAM. MULTI-DISCIPLINARY TEAM

« ANAESTHETIST

* CLINICAL CYTOPATHOLOGIST

* CLINICAL HAEMATOLOGIST

* CLINICAL PHARMACOLOGIST

« EMERGENCY MEDICINE SPECIALIST

* GASTROENTEROLOGIST

* GERIATRICIAN

* GYNAECOLOGICAL ONCOLOGIST

* IMMUNOLOGIST

* INFECTIOUS DISEASES PHY SICIAN

* INFECTIOUS DISEASES SPECIALIST

* INTENSIVE CARE ANAESTHETIST

* INTENSIVE CARE MEDICINE SPECIALIST
« MEDICAL DIAGNOSTIC RADIOGRAPHER
« MEDICAL ONCOLOGIST

* NEPHROLOGIST

* NEUROLOGIST

* NEUROSURGEON

* NUCLEAR MEDICINE TECHNOLOGIST

* ORAL AND MAXILLOFACIAL SURGEON
* ORTHOPAEDIC SURGEON

* ORTHOPTIST

* PALLIATIVE MEDICINE PHY SICIAN

*« PATHOLOGIST

* PLASTIC AND RECONSTRUCTIVE SURGEON
* PUBLIC HEALTH PHYSICIAN

* RADIATION ONCOLOGIST

* RADIOLOGIST

* RADIOTHERAPIST

* RESPIRATORY PHYSICIAN

* RHEUMATOLOGIST

*« SEXUAL HEALTH PHYSICIAN

» SPECIALIST MEDICAL PRACTITIONER
« SPECIALIST PHYSICIAN

Medical Specialist | Specialist other or not specified

* UROLOGIST
* VETERINARIAN
AUDIOLOGIST Allied Health Professional | Audiologist / audiometrist
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Table 7. Communicare to AIHW provider type mapping (continued)

Communicar e Speciality

AIHW provider type

BTH COUNSELLOR

Social and Emotional Well Being staff | Counsellor

CARDIOLOGIST

Medical Specidlist | Cardiologist

* CARDIOTHORACIC PHY SIOTHERAPIST
* PHYSIOTHERAPIST
* RESPIRATORY PHY SIOTHERAPIST

Allied Health Professional | Physiotherapist

* CARDIOTHORACIC SURGEON
* SURGEON
* VASCULAR SURGEON

Medical Specialist | Surgeon

¢ CHILD HEALTH NURSE

*« ENROLLED NURSE

* ENROLLED NURSE (MENTAL HEALTH)

* MOTHERCRAFT NURSE

* NURSE EDUCATOR

* NURSE MANAGER

* NURSE PRACTITIONER

* NURSE RESEARCHER

* REGISTERED NURSE

* REGISTERED NURSE (DEVT'L DISABILITY)
* REGISTERED NURSE (MENTAL HEALTH)

Nurses

* CLINICAL PSYCHOLOGIST
* NEUROPSY CHOLOGIST
* PSYCHOLOGIST

Socia and Emotional Well Being staff | Psychol ogist

* DENTAL - TECHNICIAN OR PROSTHETIST
« DENTAL ASSISTANT

* DENTAL PROSTHETIST

*« DENTAL TECHNICIAN

Dental support (e.g. dental assistant / dental technician)

« DENTAL HYGIENIST
* DENTAL SPECIALIST
*« DENTAL THERAPIST
« DENTIST

Dentists/ dental therapists

DERMATOLOGIST

Medical Specialist | Dermatologist

DIABETES EDUCATOR

Allied Health Professional | Diabetes educator

DIETITIAN

Allied Health Professional | Dietician

*« DRUG AND ALCOHOL COUNSELLOR
* SUBSTANCE MISUSE WORKER

Substance misuse / drug and alcohol worker

EAR, NOSE AND THROAT SPECIALIST

Medical Specialist | Ear Nose and Throat Specialist

ENDOCRINOLOGIST

Medical Specialist | Endocrinologist

GENERAL MEDICAL PRACTITIONER

Doctor - General Practitioner

MIDWIFE

Midwives

OBSTETRICIAN AND GYNAECOLOGIST

Medical Specidlist | Obstetrician / Gynaecol ogist

OPHTHALMOLOGIST

Medical Specialist | Ophthalmologist

OPTOMETRIST Allied Health Professional | Optometrist
PAEDIATRICIAN Medical Specialist | Paediatrician

PHARMACIST Allied Health Professional | Pharmacist
PODIATRIST Allied Health Professional | Podiatrist
PSYCHIATRIST Medical Specialist | Psychiatrist/Psychiatric Register

RENAL MEDICINE SPECIALIST

Medical Specialist | Renal Medicine Specialist

(c)Telstra Health | Communicare
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Table 7. Communicare to AIHW provider type mapping (continued)

Communicar e Speciality AIHW provider type

SEXUAL HEALTH WORKER Sexual health worker

* SMOKING CESSATION COORDINATOR Tobacco worker / coordinator

* SMOKING CESSATION OFFICER
SOCIAL WORKER Social and Emotional Well Being staff | Social Worker
TRADITIONAL HEALER Traditional healer
TRANSPORT WORKER Transport worker
WELFARE WORKER Social and Emotional Well Being staff | Welfare Worker

Note: Any other speciality types that may be added from time to time will be mapped to ‘ Other
health / clinical staff’ unlessthereis aclear mapping available. In some cases, this may be a
temporary mapping pending a decision from the AIHW as to the preferred grouping.

Reporting parameters

Reporting periods

National KPI reports are due at the end of the calendar year and the end of the financial year (31 December
and 30 June). The nominal report period is one year but some of the reports are ‘ point in time' assessments as
of the end of the report period. In these cases, there will be a currency period defined. For example, patients
who, at the end of the report period, have had an HbA1c in the previous six months. See each indicator for
details.

The OSR reports are due at the end of the financial year (30 June). Again, the nominal report period is one
year.

Report parameters

nNKPI report parameters

nKPI reports have the following parameters:

« Locality Group - displaysalist of al the locality groups configured on the database. Typically select
one of the following:
°o<All Locality G oups> - effectively bypasses any reference to a patient’s home address at
the end of the report period. Choose this option unless a decision has been made to exclude some
patients based on where they lived at the end of the report period. For example, health services
with large numbers of frequent visitors whose main health service is elsewhere.
°oHeal th Service Area - limitsthereport to patients whose home address at the end of the
report period was alocality defined in thislocality group. It isthe health service' s responsibility
to make sure that this locality group covers the full geographical area covered by the health
service. This option will effectively exclude frequent visitors from outside the health service
area.
All other options are defined by the health service. The only times another locality group should be
chosen isfor internal reporting where a health service has multiple clinics covering different areas and
for the few databases that cover more than one organisation where each is required to report separately
to the Health Data Portal.

32 GRT & nKPI Reference Guide



« Patient Indicator - must be set to Al HW Regul ar i ent, unlessthe report is being used for internal
reporting only and Conmuni care Current Pati ent statusismorerelevant to the health service.

» Last Report Date - either 31st Decenber or 30t h June of the relevant year. However, for internal
reporting only, interim dates can be set. Typically choose the last date of any month rather than
other dates of the month, because some indicators that look back ayear or six monthsto determine a
currency of some data values will round to the nearest month.

There are some exceptions to the parameters presented for specific nKPI reports:

* PI01 and P102 - you cannot select a patient indicator because al children born in the report period
who have been added to the database prior to the end of the report period are included, unless they are
Fictitious or were a Non-Patient at the end of the report period.

* P18 and P119 (eGFR) - include an additional parameter of Chr oni ¢ Di sease to allow the report to
be generated for either Diabetes Type |l patients or Cardiovascular disease patients. Some patients with
co-morbidities will appear in both options so totalling numbers from both must be done with care.

Note: There are two reports for each nKPI: one contains the totalsin a grid and the other lists patient
names for internal data verification and clinical action only.

OSR report parameters

OSR reports al have the following parameters:

» End of Year to Report - set to 30t h June of the relevant year. For internal reporting purposes, any
date can be selected. Typically, choose the last date of any month rather than other dates of the month
because some indicators that ook back ayear or six months to determine a currency of some data
values will round to the nearest month.

* Locality Group - see description above (on page 32).

Encounter place subset parameter (optional)

An optional Encounter place subset parameter is available on the nKPI reports and the OSR reports CS-1,
CS-2 and CS-3. It is not supported by the GRT, so any reporting using an encounter place subset must be
submitted manually to the Health Data Portal .

This option isrelevant for health services where only some of the encounter places need to report nKPI or
OSR data.

Contact Communicare Support to configure subsets of encounter place for reporting.

NKPI summary
Summary of NKPI reports.
PJ Note: Thisinformation relatesto Specification V13.2 of the National Key Performance Indicators

and On-line Services Reporting (NPS MedicineWise, Specifications for national Key Performance
Indicators and Online Services Reporting V13.2. Sydney: NPS MedicineWise, 2022).
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Table 8. NKPI reports

NKPI report

Description

Further information

Pl 01

Indigenous babies born within the
previous 12 months whose birth weight
has been recorded

Pl 01 (on page 35)

Pl 02

Indigenous babies born within the
previous 12 months whose birth weight
results were low, normal, or high

Pl 02 (on page 36)

Pl 03

Regular clients for whom an MBS Health
Assessment for Aboriginal and Torres
Strait Islander People (MBS Item 715 or
equivalent) was claimed

Pl 03 (on page 37)

Pl 04

Indigenous children who are fully
immunised

Suspended June 2021

Pl 05

Regular clientswith Type |l diabetes
who have had an HbA 1c measurement
result recorded

Pl 05 (on page 38)

Pl 06

Regular clientswith Type |l diabetes
whose HbA 1c measurement result was
within a specified level

Pl 06 (on page 39)

Pl 07

Regular clients with a chronic disease
for whom a GP Management Plan (MBS
Item 721) was claimed

Pl 07 (on page 39)

Pl 08

Regular clients with a chronic disease for
whom a Team Care Arrangement (MBS
Item 723) was claimed

Retired June 2021

Pl 09

Regular clients whose smoking status has
been recorded Communicare

Pl 09 (on page 41)

Pl

10

Regular clients with a smoking status
result Communicare

Pl 10 (on page 41)

Pl

11

Smoking in Pregnancy

Pl 11 (on page 41)

Pl

12

Body mass index of clients

Pl 12 (on page 42)

Pl

13

Regular clients who had their first
antenatal care visit

Pl 13 (on page 43)

Pl

14

Regular clients aged 6 months and over
who are immunised against influenza

Pl 14 (on page 43)

Pl

15

Regular clientswith Type Il diabetes
or COPD who are immunised against
influenza

Retired December 2021

Pl

16

Regular clients whose alcohol
consumption status has been recorded

Pl 16 (on page 44)

Pl

17

Regular clients who had an AUDIT-C
with result within specified levels

Pl 17 (on page 44)

Pl

18

Proportion of Indigenous regular clients
with a selected chronic disease who have
akidney function test result recorded.

Pl 18 (on page 45)

Pl

19

Proportion of Indigenous regular clients
with a selected chronic disease who have
had a kidney function result (eGFR and
ACR) within a specified level.

Pl 19 (on page 47)

Pl

20

Regular clients who have had the
necessary risk factors assessed to enable
CVD assessment

Pl 20 (on page 49)
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Table 8. NKPI reports (continued)

NKPI report

Description Further information

Pl 21

Regular clients aged 35to 74 yearswho | Pl 21 (on page 49)
have had an absol ute cardiovascul ar
disease risk assessment with results
within specified levels

Pl 22

Regular clients who have had acervical | Pl 22 (on page 50)
screening disaggregated by age groups

Pl 23

Regular clientswith Type |l diabetes Pl 23 (on page 51)
who have had a blood pressure
measurement result recorded

Pl 24

Regular clientswith Type |l diabetes Pl 24 (on page 52)
whose blood pressure measurement
result was less than or equal to 140/90
mmHg

Pl 25

Proportion of Indigenous regular clients | Pl 25 (on page 53)
who have atest result for one or more
sexually transmissible infections (STI).

Total Number of Clients Not distributed with Communicare at this
time

PI 01 - Birthweight recorded

Proportion of Indigenous babies born within the previous 12 months whose birth weight has been recorded.

Notes

* Birth weights are obtained from the infant's record.
« Birth weight may be recorded either in the infant's biographics or as aweight qualifier recorded on day

of birth.

* All birthsin last 12 months are considered whether infant was aregular client or not.
* Theinfant must have at least one recorded visit to the health service.

Table 9. NKPI Pl 01

Element

Description

Communicare reports

* Report > National KPI > PI01 Birth Weight Recorded
* Report > National KPI > PI101 Birth Weight Recorded Patients

Numerator

A patient must have a birth weight recorded in either:

* Biographics > Birth weight

Pessonal | Social | Administiation | Addiional |

Mames + = Sex |Famae =| DateofBith [0/05/2021 | [T Estimated Bithweight | 3175 Kg
Forsnames Famiy Name Predened |Hed-c>sleIH| [Nmalu 1
}|BABY OF THERESA [ F F r
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Table 9. NKPI Pl 01 (continued)

Element Description

» Weight qualifier on any clinical item that has the same performed date as the
patient’s date of birth, suchasBirth details.

Birth details

Use this item to record measurements taken at bith. Record this information in the II

(cms) and weight must be recorded in kalograms (kg). Ensure the date is changed to
Chistine Elison, Milennium Heath Senice (Abodginal Health Senvice) 05/05/72021 10:54:45 AM
Conreeri
Date of Bath 050522021 -l
Height & em
\Wieight 275 kg
Denominator « All patient records where the date of birth iswithin the report period and who

are Indigenous are included unless they were added after the end of the report
period, are fictitious or were a non-patient at the end of the report period.

« Patients are excluded if their birth weight is known to be less than 400g or their
gestation at birth is known to be less than 20 weeks.

« If the birth weight and gestation at birth are both unknown they are included.

Additional data recording If birth weight is not recorded on the biographics form but isrecorded on the Bi rt h
considerations det ai | s clinical item, thisitem must have the same date as the date of birth of the
patient.

To audit incorrect dates on thisitem, use the report at Report > Patients > Birth
Details Audit.

Pl 02 - Birthweight result

Proportion of Indigenous babies born within the previous 12 months whose birth weight has been recorded

Notes

* Birth weight is categorised as one of the following:
o Low - less than 2,500 grams
> Normal - 2,500 grams to less than 4,500 grams
> High - 4,500 grams and over
* Birth weights are obtained from the infant's record.
* Birth weight may be recorded either in the infant's biographics or as aweight qualifier recorded on the
day of birth.
« All birthsin the last 12 months are considered, whether the infant was aregular client or not.
* Theinfant must have at least one recorded visit to the health service.

Table 10. NKPI Pl 02
Element Description

Communicare reports * Report > National KPI > P02 Birth Weight Categories
* Report > National KPI > P102 Birth Weight Categories Patients

Numerator Asfor the numerator rules for PIO1 (on page 35) but disaggregated into the three
categories of Low, Normal and High.
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Table 10. NKPI PI 02 (continued)

Element

Description

Denominator

Asfor the denominator rules for PIO1 (on page 35).

Additional data recording
considerations

Asfor PIO1 (on page 35).

PI 03 - Indigenous Health Assessment completed

Proportion of regular clients who received an MBS Health Assessment for Aboriginal and Torres Strait
Islander People (MBS Item 715 or any equivalent such as 228, 92004, 92016, 92011 or 92023).

Description

Proportion of Indigenous regular clients who are either:

» Aged 0-14 years and who have received an MBS Health Assessment for Aboriginal and Torres Strait
Islander People within the previous 12 months

+ Aged 15 years and over and who have received an MBS Health Assessment for Aboriginal and Torres
Strait Islander People within the previous 24 months

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait |slander or both.

* A patient is deemed to have received an MBS Health Assessment if a service hasthe MBSitem
selected for claiming, regardless of whether it has been submitted or paid.

Table 11. NKPI Pl 03

Element

Description

Communicare reports

* Report > National KPI > PI03 Health Checks
* Report > National KPI > PI103 Health Checks Patients

Numerator

A documented 715 (or any equivaent such as 228, 92004, 92016, 92011 or 92023)
claim for a service within one year (0-14 year olds) or two years (15+ year olds) of the
end of the report period is required. For more information, see Medicare claims (on
page 20).

« Calculation A: Number of [ Disaggregation: Gender] Indigenous regular
clients aged [ Disaggregation: Age] who have a current completed in-person
MBS-rebated Indigenous health assessment (MBS items: 715 or 228)

« Calculation B: Number of [ Disaggregation: Gender] Indigenous regular
clients aged [ Disaggregation: Age] who have a current completed Telehealth
MBS-rebated Indigenous health assessment (MBS items: 92004, 92016, 92011
or 92023)

Denominator

Regular, Indigenous patients as of the end of the report period.

« Calculation A and B: total number of [ Disaggregation: Gender] Indigenous
regular clients aged [ Disaggregation: Age]

Disaggregation

* Age:
o 04 years
o 5-14 years
o 15-24 years
o 25-34 years
o 35-44 years

(c)Telstra Health | Communicare
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Table 11. NKPI Pl 03 (continued)

Element Description

o 45-54 years
o 55-64 years
> 65 yearsand older
 Gender:
> Mae
> Female
* Type of health assessment:
° In-person MBS-rebated Indigenous health assessment
o Telehealth MBS-rebated | ndigenous health assessment

Additional datarecording none
considerations

Pl 05 - HbA1c recorded

Proportion of regular clients with Type Il diabetes who have had an HbA 1c measurement result recorded.
Description

Proportion of Indigenous regular clients who have either:

* Type Il diabetes and who have had an HbA 1¢c measurement result recorded within the previous 6
months

* Type |l diabetes and who have had an HbA 1¢c measurement result recorded within the previous 12
months

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

* Patients must be recorded as Aborigina or Torres Strait Islander or both.

* Only Type Il diabetesis considered (any ICPC code of T90). Type | diabetes, secondary diabetes,
gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose, impaired glucose
tolerance are not included. For more information, see System codes (on page 18).

» Any qualifier with a system code of HBA and units of %or a system code of HBMand units of nmol /
mol isconsidered an HbA 1c measurement. These results can be received from an incoming pathology
report or manually entered into an existing Clinical Item with aqualifier of HbA1c. For more
information, see Qualifier codes (on page 19).

Table 12. NKPI Pl 05
Element Description

Communicare reports * Report > National KPI > PI05 Diabetes HbAlc Tests
* Report > National KPI > PI05 Diabetes HbA1c Tests Patients

Numerator Any of the patients included who have a recorded HbA 1c within 6 months or 12
months of the end of the report period. For more information about codes, see
Procedure, Immunisation, Pathology & Medicare codes reference (on page 24).

Denominator Regular, Indigenous patients with a diagnosis of Type Il diabetes from any time. For
more information about codes, see Condition codes reference (on page 20).

Additional data recording Clinicians must record HbA 1c results correctly. They should not enter a % result in the

considerations HbA1c qualifier or ammol/mol result in the HbA1c (%) qualifier.
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Table 12. NKPI PI 05 (continued)

Element

Description

Use Report > Qualifiers> With Selected Numeric valuesto look for outliers such as
abnormally high % values or abnormally low mmol/mol values. For more information,
see Qualifier codes (on page 19).

Mistakes should be corrected.

Pl 06 - HbA1c result

Proportion of regular clients with Type 11 diabetes whose HbA 1¢c measurement result was within a specified

level

Description

Number of Indigenous regular clients who have Type |l diabetes and who have had an HbA 1¢c measurement
result recorded within the previous 6 or 12 months.

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

* Only Type Il diabetesis considered (any ICPC code of T90). Type | diabetes, secondary diabetes,
gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose, impaired glucose
tolerance are not included. For more information, see System codes (on page 18).

» Any qualifier with a system code of HBA and units of %or a system code of HBMand units of nmol /
mol is considered an HbA 1c measurement. These results can be received from an incoming pathology
report or manually entered into an existing Clinical Item with aqualifier of HbA1c. For more
information, see Qualifier codes (on page 19).

* Only the most recent HbA 1¢ measurement result for each time period is considered.

Table 13. NKPI Pl 06

Element

Description

Communicare reports

* Report > National KPI > P06 Diabetes HbA1c Results 06 Months
* Report > National KPI > P106 Diabetes HbA1c Results 12 Months
* Report > National KPI > P106 Diabetes HbA1c Results Patients

Numerator The latest HbA 1c within the specified time period is used. If it wasrecorded as % it is
first converted to mmol/mol and rounded to a whole number after multiplying by 10.93
and adding 23.5. The groupings are less than or equal to 53 mmol/mol, greater than 53
and less than or equal to 64 mmol/mol and less than 86 mmol/mol.

Denominator Regular, Indigenous patients with a diagnosis of Type Il diabetes from any time.

Additional datarecording
considerations

Clinicians must record HbA 1c results correctly. They should not enter a % result in the
HbA 1c qualifier or ammol/mol result in the HbA 1c (%) qualifier.

Use Report > Qualifiers> With Selected Numeric valuesto look for outliers such as
abnormally high % values or abnormally low mmol/mol values.

Mistakes should be corrected.

Pl 07 - Chronic Disease Management Plan prepared

Proportion of regular clients with a chronic disease who have received a GP Management Plan (MBS Item
721 or any equivalent such as 229, 92024, 92068, 92055, 92099).

(c)Telstra Health | Communicare
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Description

Proportion of Indigenous regular clients who have Type |l diabetes and who have received a GP Management
Plan (MBS Item 721 or any equivalent such as 229, 92024, 92068, 92055, 92099) within the previous 24
months.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

* A patient is deemed to have received a GP Management Plan if a service has the MBS item checked for
claiming, regardless of whether it has been submitted or paid.

Table 14. NKPI Pl 07

Element Description
Communicare reports * Report > National KPI > PI07 Diabetes GP M anagement Plan
* Report > National KPI > P107 Diabetes GP M anagement Plan Patients
Numerator Currently this report looks for evidence of a 721 (or any equivalent such as 229,92024,
92068, 92055, 92099) Medicare claim. For more information, see Medicare claims (on
page 20).
Denominator Currently thisindicator looks only for patients with Type |1 diabetes.
Additional datarecording Health Services who are part of the Health Care Homes trial will not be documenting
considerations care plans with a claim for item 721 or any equivalent such as 229, 92024, 92068,

92055, 92099 so will need to document these care plans with aclinical item.

From June 2018 thisindicator will also recognise a completed procedure with an export
code of CPA as being evidence of a care plan being completed.

PI 09 - Smoking status recorded

Proportion of regular clients whose smoking status has been recorded.

Description

Proportion of Indigenous regular clients who have had their smoking status recorded.
Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Patients must have had a qualifier recorded with a system code of SMO or SMP to be included. Central
gualifiersare Snoki ng st at us and Snoki ng duri ng pregnancy. For more information, see
Qualifier codes (on page 19).

Table 15. NKPI Pl 09
Element Description

Communicare reports * Report > National KPI > PI09 Smoking Status
* Report > National KPI > PI09 Smoking Status Patients
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Table 15. NKPI Pl 09 (continued)

Element Description
Numerator The latest smoking status recorded before the end of the report period is used: thereis
no currency period. For details of system codes used to identify smoking statuses, see
Procedure, Immunisation, Pathology & Medicare codes reference (on page 24).
Denominator Regular, Indigenous patients aged 11 years and over.
Additional data recording none
considerations

Pl 10 - Smoking status

Proportion of regular clients whose smoking status has been recorded.

Description

Proportion of Indigenous regul

Notes

ar clients who have had their smoking status recorded.

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

» Patients must have had a qualifier recorded with a system code of SMO or SMP to be included. Central

gualifiers are Snoki ng
Qualifier codes (on pag

Table 16. NKPI Pl 10

st at us and Snoki ng duri ng pregnancy. For moreinformation, see
e 19).

Element

Description

Communicare reports

* Report > National KPI > PI 10 Smoking Status Result
* Report > National KPI > P110 Smoking Status Result Patients

Numerator The latest smoking status recorded before the end of the report period is used: thereis
no currency period. For details of system codes used to identify smoking statuses, see
Procedure, Immunisation, Pathology & Medicare codes reference (on page 24).

Denominator Regular, Indigenous patients aged 11 years and over who have had their smoking status

recorded.

Additional data recording
considerations

none

PI 11 - Smoking status of female Indigenous regular clients who gave birth within

the previous 12 months

Proportion of regular clientsw
recorded.

Description

Proportion of Indigenous regul

ho have given birth in the previous 12 months whose smoking status has been

ar clients who have had their smoking status recorded.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

» Patients must have had a qualifier recorded with a system code of SMOor SMP to be included. Central
gualifiersare Snoki ng st at us and Snoki ng during pregnancy. For more information, see
Quadlifier codes (on page 19).

Table17. NKPI Pl 11

Element Description
Communicare reports * Report > National KPI > PI11 Smoking in Pregnancy
* Report > National KPI > PI111 Smoking in Pregnancy Patients

Numerator The latest smoking status recorded before the end of the report period is used: thereis
no currency period.

Denominator Regular, Indigenous patients aged 11 years and over who have had their smoking status
recorded.

Additional datarecording none

considerations

Pl 12 - Body massindex of clients

Proportion of Indigenous regular clients who have a Body Mass Index (BMI) result within specified
categories.

Description

Proportion of regular clients who are Indigenous, aged 18 and over who have had their body mass index
(BMI) classified as one of the following in the previous 24 months:

» Underweight (<18.50)

* Normal weight (>=18.50 but <25)
* Overweight (>=25 but <30)

* Obese (>=30)

If thereisno BMI recorded or it was recorded more than 24 months ago, the BMI is classified as Not
cal cul at ed.

Notes

* The user may choose either AIHW's definition of Regular Client (attended the OATSIH-funded
primary health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

* Only the most recent measurement result with a system code of BMI in the previous 24 monthsis
considered.

Table 18. NKPI Pl 12
Element Description

Communicare reports * Report > National KPI > Pl 12 Overweight
* Report > National KPI > PI112 Overweight Patients
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Table 18. NKPI Pl 12 (continued)

Element Description
Numerator This report looks only for recorded BMIs, it does not calculate BMIs based on weight,
height and age.
Denominator Regular, Indigenous patients with a BMI recorded.

Additional data recording
considerations

Health services should encourage the recording of BMIsfor al patients.

Pl 13 - First Antenatal Visit

Proportion of regular female clients who received antenatal care within specified periods.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

» Any clinical item with a system code of PRE and arule code of PR- CHECK can be used. For more
information, see System codes (on page 18).

« Although the category of No resul t isincluded as part of the specifications, the additional category
of (No known antenatal care) isspecifically to report on patients where, in Communicare, the
clinical itemNo known ant enat al car e hasbeen recorded, and there is no prior or subsequent
antenatal activity recorded.

* Percentages may not add up to 100%.

Table 19. NKPI Pl 13

Element

Description

Communicare reports

* Report > National KPI > PI113 Antenatal Care
* Report > National KPI > PI13 Antenatal Care Patients

Numerator

For details of how to recognise an antenatal check, see Procedure, Immunisation,
Pathology & Medicare codes reference (on page 24).

* Always record the gestation at the time of recording an antenatal check.

« Antenatal checks recorded must have the same number as the pregnancy
outcome to be included.

* Performed date and pregnancy number must be compl eted.

Denominator

Women who have given birth in the report period.

Additional data recording
considerations

) Note: Ensure that both the gestation of the pregnancy outcome and the date of
delivery are recorded. Without these two data, the earliest antenatal check may
not be recognised unlessit has the gestation explicitly recorded at that time.

Pl 14 - Clients who are immunised against influenza

Proportion of Indigenous patients aged 6 months and over who are immunised against influenza.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
« Patients must be recorded as Aboriginal or Torres Strait |slander or baoth.
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Table 20. NKPI Pl 14

Element

Description

Communicare reports

* Report > National KPI > P114 Influenza | mmunisations
* Report > National KPI > PI14 Influenza | mmunisations Patients

Numerator For more information, see Export codes (on page 19). For details of influenza
clinical item export codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Denominator Regular, Indigenous patients aged 6 months and over at the end of the report period.

Additional datarecording
considerations

Thisreport relies on valid AIR codes for influenza vaccines being recorded as the
export code for such immunisation types. New codes may be introduced with each
Season.

Pl 16 - Alcohol consumption recorded

Proportion of regular clients whose alcohol consumption status has been recorded.

Description

Proportion of Indigenous regular clients aged 15 years and over where their health provider has recorded:

» Whether the client consumes alcohol
» The amount and frequency of the client's alcohol consumption

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
* Patients must be recorded as Aborigina or Torres Strait |slander or both.
« Patients must have had a qualifier with a system code of ALC or ALPrecorded to be included
o Central qualifiersare Al cohol Consunpti on Level and Al cohol Consunption Duri ng

Pregnancy.

o Exampleclinical itemsinclude Check up; Abori gi nal & TSI adul t, Check

up; ant enat al

o Alternatively, in the AUDI T- C assessment (Check up; al cohol ; AUDI T- C), they may have at
least the first two qualifiers recorded, or an AUDIT-C score or afull AUDIT score.

Table 21. NKPI Pl 16

Element

Description

Communicare reports

* Report > National KPI > P116 Alcohol Status
* Report > National KPI > P116 Alcohol Status Patients

Numerator Thisreport looks for any evidence in the previous two years of either alcohol
consumption level, or an AUDIT-C score or afull AUDIT score or both question 1 and
question 2 of the AUDIT C/AUDIT being recorded at the same time.

Denominator Regular, Indigenous patients.

Additional data recording
considerations

none

Pl 17 - AUDIT-C result

Proportion of regular clients who had an AUDIT-C with results (score) within specified levels.
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Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary

health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

» Any numeric qualifier with an export code of AUDI TCis considered an AUDIT-C result. For example,

in Check up; al cohol ; AUDI T- C, the three Alcohol audit interview guestions must have avalue and
the Alcohol AUDIT-C total must be calculated. These four qualifiers can be added to any clinical item
to augment data collection. For more information, seeExport codes (on page 19).

Table 22. NKPI Pl 17

Element

Description

Communicare reports

* Report > National KPI > PI17 AUDIT-C
* Report > National KPI > PI117 AUDIT-C Patients

Numerator

For details of codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

AUDIT-C results need to be documented as a numeric qualifier to be included and must

have been recorded during the two years prior to the end of the report period.
Check up;alcohol;AUDIT-C
Begin the AUDIT by saying, "Now | am going to ask you some questions about your use of alcohalic beverages during

meant by “alceholic beverages” by using local examples of beer, wine, vodka, etc
Recommended limits (double-click to view and/or print):

(Christine Elison, Milencium Health Service (Abordginal Heatth Senvdoe) 05/ 05/2021 3.58:57 PM
Comment -

Performed date | 050572021 4:05 FM |

Achual duration minwtes)

sk question "How often do you have a dink conlaining alcohel?”

ddcohol audt mtenvies 7 |ﬂjﬂotmotchnesawock _ﬂ[Nop'e\-ulsvﬂ.-csl

Ak question “How mang dinks contaning alcohol do pou have on a lypical day when wou e dirking ™
ddcohol audt mterview (2 |lj3otﬂ _ﬂ [ Ho presacus values |

Ak question “How often do you have s of mone dimks on one occasion 7
Alcohol st intervies 03 | 91 Daly or aimon daly =] 1Mo previcus vakes |

Inmen. a scoie of 4 or mone is conadened positive, aptmal for identifng hazandows dinking oo active slcohol deonders.
Ir wormen, & soone of 3 of moee i considered positres [same & sbove]

Howerver, whan al the ports ace from Question 1 slone [2 and 3 e zero). i can be assumed that the patient it diinking below 1ecomemerded bmils
patiant’s alcohol intake oved the past few months 1o confim acciracy.
Generally, the higher the: scons, the mone Bely it is that the patient’s deinking is affecting hiz or hes safeby.

ddenhol ALIDIT-C 1otal 9 soote | Ho previous vakses |

| Calculste Alcohol AUDITC totd I

Denominator

Regular, Indigenous patients aged 15 years and over.

Additional data recording
considerations

none

Pl 18 - Kidney Function Testing

Proportion of Indigenous regular clients with a selected chronic disease who have a selected kidney function

test result recorded.

Description

Proportion of regular clients who are Indigenous aged 18 years and over, who are recorded as having one of

the following:
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* Type 2 diabetes
* Cardiovascular disease (CVD)
* Type 2 diabetes and/or CVD

and who have also had one of the following:

» An estimated glomerular filtration rate (eGFR) and an albumin/creatinine ratio (ACR) test result
recorded

* Only an eGFR test result recorded

* Only an ACR test result recorded

* Neither an eGFR nor an ACR test result recorded

within the previous 12 months.
Notes

*» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

» ACR results are identified as belonging to a qualifier with the system code of ACR and eGFR results
areidentified as belonging to a qualifier with the system code of GFE. Both laboratory and manually
entered results are included. For more information, see System codes (on page 18).

Table 23. NKPI PI 18
Element Description

Communicare reports * Report > National KPI > PI18 Kidney Function
* Report > National KPI > PI18 Kidney Function Patients

Numerator ACR and eGFR results must be within 12 months of the end of the report period. Both
CVD and diabetes patients are disaggregated by whether or not they have both an
eGFR,and ACR, or neither.

Denominator Regular, Indigenous patients aged 18 years and over at the end of the report period with
Type 2 diabetes or CVD.

For more information about condition codes, see Condition codes reference (on page
20).

Disaggregation * Age

o 1824 years
o 25-34 years
o 35-44 years
o 45-54 years
o 55-64 years
° 65 years and older
» Gender
o> Mae
> Femae
« Chronic disease
> Type 2 diabetes
o Cardiovascular disease
o Either or both of the above
e Test
> an eGFR only
> an ACR only
o both an eGFR and an ACR
> neither an eGFR nor an ACR
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Table 23. NKPI Pl 18 (continued)

Element Description
Additional datarecording * Type 2 diabetes — specifically excludes Type | diabetes, secondary diabetes,
considerations gestational diabetes mellitus (GDM), previous GDM, Impaired fasting glucose,

and impaired glucose tolerance

* ACR —refersto an albumin/creatinine ratio

« an eGFR only — arecorded eGFR result, where an ACR result HAS NOT been
recorded

» an ACR only — arecorded ACR result, where an eGFR result HAS NOT been
recorded

* both an eGFR and an ACR — arecorded eGFR result AND arecorded ACR
result

« neither an eGFR NOR an ACR —an eGFR result AND an ACR result HAS
NOT been recorded

* Negative ACR and eGFR values are reported as not recorded

Pl 19 - Kidney function test result

Proportion of Indigenous regular clients with a selected chronic disease who have had akidney function result

(eGFR and ACR) within a specified level.

Description

Proportion of regular clients who are Indigenous aged 18 years and over, who are recorded as having one of
the following:

* Type 2 diabetes
+ Cardiovascular disease (CVD)
* Type 2 diabetes and/or CVD

whose estimated glomerular filtration rate (e€GFR) AND albumin/creatinine ratio (ACR) recorded within the
previous 12 months were categorised as:

* Normal risk

» Low risk

* Moderate risk
* High risk

Table 24. eGFR & ACR risk categories

Risk level Description

Normal risk eGFR greater than or equal to 60 mL/min/1.73m? and:

* ACR less than 3.5 mg/mmol for females
* ACR less than 2.5 mg/mmol for males.

Low risk  eGFR greater than or equal to 45 mL/min/1.73m? and less than 60 mL/min/1.73m?
and either:
> ACR less than 3.5 mg/mmol for females
> ACR less than 2.5 mg/mmol for males.
OR
» eGFR greater than or equal to 60 mL/min/1.73m?2 and either:
> ACR greater than or equal to 3.5 mg/mmol and less than or equal to 35
mg/mmol for females
> ACR greater than or equal to 2.5 mg/mmol and less than or equal to 25
mg/mmol for males.
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Table 24. eGFR & ACR risk categories (continued)

Risk level

Description

Moderate risk

» eGFR greater than or equal to 45 mL/min/1.73m?2 and less than 60 mL/min/1.73m?
and either:
> ACR greater than or equal to 3.5 mg/mmol and less than or equal to 35
mg/mmol for females
o ACR greater than or equal to 2.5 mg/mmol and less than or equal to 25
mg/mmol for males.
OR
» eGFR greater than or equal to 30 mL/min/1.73m? and less than 45 mL/min/1.73m?2
and either:
> ACR less than 35 mg/mmol for females
o ACR less than 25 mg/mmol for males

High risk

» eGFR greater than or equal to 30 mL/min/1.73m? and either:
o ACR greater than 35ml/mmol for females
> ACR greater than 25mg/mmol for males mg/mmol
OR
* eGFR less than 30 mL/min/1.73m2 and :
o Any ACR result for both females and males

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

Table 25. NKPI Pl 19

Element

Description

Communicare reports

* Report > National KPI > PI19 Kidney Function Results Patients
* Report > National KPI > P119 Kidney Function Results

Numerator » ACR results are identified as belonging to a qualifier with the system code
of ACR. Both laboratory and manually entered results are included. For more
information, see System codes (on page 18).
* eGFR results are identified as belonging to a qualifier with the system code of
GFE. Both laboratory and manually entered results are included. GFR results
of >60 areincluded inthe group Greater than or equal to 60 but |ess
t han 90.
Denominator Regular, Indigenous patients aged 18 years and over at the end of the report period with
Typell diabetesor CVD.
Disaggregation * Age
o 1824 years
o 25-34 years
o 3544 years
o 45-54 years
o 55-64 years
o 65 years and older
» Gender

o Madle- calculation A
> Female - calculation B
« Chronic disease
> Type 2 diabetes
o Cardiovascular disease
o Either or both of the above

Additional datarecording
considerations

* Where an eGFR result of >60 has been returned by alab these are reported as
Greater than or equal to 60 but |ess than 90.
« Renal function risk result classifications differ between males and females.
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Table 25. NKPI Pl 19 (continued)
Element Description

* Type 2 diabetes — specifically excludes Type | diabetes, secondary diabetes,
gestational diabetes mellitus (GDM), previous GDM, Impaired fasting glucose,
and impaired glucose tolerance

» ACR —refersto an albumin/creatinine ratio

* Negative ACR and eGFR values are reported as not recorded

Pl 20 - CVD risk assessment factors

Proportion of regular clients who have had the necessary risk factors assessed to enable cardiovascular disease
(CVD) assessment

Description

Proportion of Indigenous regular clients with no known cardiovascular disease (CVD), assessed aged 35 to 74,
with information available to calculate their absolute CVD risk.

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
« Patients must be recorded as Aboriginal or Torres Strait |slander or baoth.
» Patients must have a sex and date of birth.
» Patients must have the following recorded in the previous 24 months:
> Smoking status (reference qualifier with system code of SMOor SMP).
o Systalic blood pressure (numeric qualifier with system code of BPS).
o Either total cholesterol and HDL (numeric qualifiers with system codes of CHOand HDL) or
cholesterol/HDL level (numeric qualifier with system code of CHR).
o For more information about qualifier system codes, see Qualifier codes (on page 19).

Table 26. NKPI PI 20

Element Description
Communicare reports  Report > National KPI > PI20 CVD Risk Factors
* Report > National KPI > PI20 CVD Risk Factors Patients
Numerator All defined measures must have been recorded in the previous two years.
Denominator Regular, Indigenous patients aged 35 years and under 75 years old at the end of the

report period without a CVD diagnosis.

For more information about condition codes, see Condition codes reference (on page
20).

Additional datarecordin : . . _—
considerations g Pl Note: some patients will not have all the measures recorded, but will still have

an absolute CV risk recorded for indicator Pl 21 (on page 49). This may

be a data entry issue or may relate to some patients who can have a high risk
inferred due to age and other conditions. For example, over 60 years with
diabetes and microalbuminuria.

Pl 21 - CVD risk assessment result

Proportion of regular clients aged 35 to 74 years who have had an absolute cardiovascular disease (CVD) risk
assessment with results within specified levels.

(c)Telstra Health | Communicare 49



Description

Proportion of Indigenous regular clients, aged 35 to 74 and with no known history of cardiovascular disease
(CVD), who have had an absolute CVD risk assessment recorded within the previous 24 months and whose
CVD risk was categorised as one of the following:

« High (greater than 15% chance of a cardiovascular event in the next 5 years)
* Moderate (10-15% chance of a cardiovascular event in the next 5 years)
* Low (lessthan 10% chance of a cardiovascular event in the next 5 years)

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

* Patients must have a sex and date of birth.

« Patients must have arecord of their cardiovascular risk (high, moderate or low) recorded within the
previous 24 months. For the purpose of this report the cardiovascular risk needs to be recorded as a
reference type qualifier or anumeric type qualifier with appropriate export or system codes:

> For CARPA STM guidelines, either of the following:
= Reference type qualifier with an export code of CVR- RO5C and dropdown references with
system codes of H, Mor L (for high, moderate or low)
= Numeric type qualifier with units of % and an export code of CVR- NO5C

Note: CARPA STM results will be adjusted for Aboriginal patients to remove the 5%
loading and Aboriginal patients aged between 20 and 34 years are not included in this
report.

> For Framingham cal culations either of the following:
= Reference type qualifier with an export code of CVR- RO5F and dropdown references with
system codes of H, Mor L (for high, moderate or low)
* Numeric type qualifier with units of % and an export code of CVR- NO5F

Table 27. NKPI PI 21
Element Description

Communicare reports * Report > National KPI > PI21 CVD Risk
* Report > National KPI > PI21 CVD Risk Patients

Numerator For details of absolute CV risk export codes, see Procedure, Immunisation, Pathology
& Medicare codes reference (on page 24).

Denominator Regular, Indigenous patients aged 35 years and under 75 years old at the end of the
report period with a CV risk assessment but without a CVD diagnosis.

For more information about condition codes, see Condition codes reference (on page

20).
Additional datarecording Health services should determine if they are going to use the Framingham or CARPA
considerations calculator distributed with Communicare and consider disabling the one they do not

use. Thisreport will use Framingham scores as they are recorded but will remove the
5% loading that the CARPA calculation does for Indigenous patients before reporting.
Also, see comments for Pl 20 (on page 49).

Pl 22 - Female clients who have had a cervical screening (HPV) test

Proportion of female Indigenous regular clients who have had a cervical screening (HPV) test
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Description

Proportion of female Indigenous regular clients aged 25-74, who have not had a hysterectomy and who
have had a cervical screening (human papillomavirus (HPV)) test within the previous 5 years where the test
occurred on or after 1 December 2017.

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait Islander or both.

* A cervical screening result is any incoming electronic pathology result identified as being a cervical
screening where its laboratory description contains CST, HPV, LBC, CERVICAL SCREEN,
GYNAECOLOGICAL CYTOLOGY or NCSP.

* A cervical screening request is a pathology request which has a keyword of CST, HPV, or LBC.

* A cervical screening clinical item is a completed item of any class with the export code of CST, HPV or
LBC.

* A cervical screening qualifier is any qualifier which isa'Yes/No qualifier with the export code of CST,
HPV or LBC where the response recorded was Yes.

Table 28. NKPI Pl 22

Element Description
Communicare reports * Report > National KPI > PI122 Cervical Screening
* Report > National KPI > P122 Cervical Screening Patients
Numerator For details of how evidence of acervical screening is determined, see Procedure,
Immunisation, Pathology & Medicare codes reference (on page 24).
Denominator Regular, Indigenous women aged 25 years and above to less than 75 years.
Additional data recording none

considerations

Pl 23 - Blood Pressure recorded

Proportion of regular clients with Type 2 diabetes who have had a blood pressure measurement result
recorded.

Description

Proportion of regular clients who are Indigenous, have Type 2 diabetes and who have had a blood pressure
measurement result recorded at the primary health care service within the previous 6 months.

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

» Patients must be recorded as Aboriginal or Torres Strait |slander or both.

» Only Type Il diabetesis considered (any ICPC code of T90). Type | diabetes, secondary diabetes,
gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose, impaired glucose
tolerance are not included. For more information, see System codes (on page 18).

» Any qualifier with a system code of BPS or BPD is considered a systolic or diastolic blood pressure
measurement. For more information, see Qualifier codes (on page 19).
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Table 29. NKPI Pl 23

Element

Description

Communicare reports

* Report > National KPI > P123 Diabetes BP Tests
* Report > National KPI > P123 Diabetes BP Tests Patients

Numerator

Both diastolic and systolic blood pressure must be recorded at the same time.

Denominator

Regular, Indigenous patients with a diagnosis of Type Il diabetes from any time.

For more information about condition codes, see Condition codes reference (on page
20).

Additional datarecording
considerations

,'~ Note: Loca clinica items should not contain more than one qualifier with
the system code of BPS and one with the system code of BPD as thisis not
currently supported and may lead to anomalies in both Pl 23 and P124.

For more information, see Qualifier codes (on page 19).

Pl 24 - Blood Pressure result

Proportion of Indigenous regular clients with Type 2 diabetes whose blood pressure measurement result was

within specified categories

Description

Proportion of regular clients who are Indigenous, have Type 2 diabetes and whose blood pressure
measurement result, recorded within the previous 6 months, was less than or equal to 140/90 mmHg.

Notes

* User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary
health care service at least 3 timesin 2 years), or Communicare's Current Patient status.

« Patients must be recorded as Aboriginal or Torres Strait |slander or both.

* Only Type Il diabetesis considered (any ICPC code of T90). Type | diabetes, secondary diabetes,
gestational diabetes mellitus (GDM), previous GDM, impaired fasting glucose, impaired glucose
tolerance are not included. For more information, see System codes (on page 18).

* The patient does not have a blood pressure measurement of less than or equal to 140/90 mmHgq if either
the systolic or diastolic reading is above the threshold (140 and 90 respectively).

* Only the most recent blood pressure measurement result in previous 6 months is considered.

Table 30. NKPI Pl 24

Element

Description

Communicare reports

* Report > National KPI > PI24 Diabetes BP Results
* Report > National KPI > P24 Diabetes BP Results Patients

Numerator Both diastolic and systolic blood pressure must be recorded at the same time.
A blood pressure is deemed to be low if the systolic value is 140 or less and the
diastolic valueis 90 or less.

Denominator Regular, Indigenous patients with adiagnosis of Type Il diabetes from any time who

have a blood pressure recorded.

For more information about condition codes, see Condition codes reference (on page
20).
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Table 30. NKPI Pl 24 (continued)

Element

Description

Additional data recording
considerations

,'* Note: Local clinical items should not contain more than one qualifier with
the system code of BPS and one with the system code of BPD as thisis not
currently supported and may lead to anomaliesin both Pl 23 and P124.

For more information, see Qualifier codes (on page 19).

Pl 25 - STI result recorded

Proportion of Indigenous regular clients who have atest result for one or more sexually transmissible

infections (ST1).

Description

Proportion of Indigenous regular clients aged 15 to 34 years who had an STI result recorded within the

previous 12 months for:

» Chlamydia
» Gonorrhoea

 Chlamydia and/or gonorrhoea

Notes

» User may select between AIHW's definition of Regular Client (attended the OATSIH-funded primary

health care service at least 3 timesin 2 years), or Communicare's Current Patient status.
« Patients must be recorded as Aboriginal or Torres Strait |slander or both.
» Patients deceased at end of reporting period are not included.
» An STI result is any incoming electronic pathology result identified as being a chlamydia or

gonorrhoeatest.

Table 31. NKPI PI 25

Element

Description

Communicare reports

* Report > National KPI > PI25 ST Results Patients
» Report > National KPI > PI25 ST| Results

Numerator

The number of regular clients aged 15-34 years who have had a chlamydia and/or
gonorrhoeatest result recorded within the previous 12 months.

Denominator

The number of regular, Indigenous patients aged 15-34 years at the end of the report
period

Disaggregation

* Age
o 15-19 years
o 20-24 years
o 25-29 years
o 30-34 years
» Gender
> Male
o Female

Additional data recording
considerations
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OSR summary
Summary of OSR reports.

Note: Thisinformation relates to Specification 11.0 of the National Key Performance Indicators and
On-line Service Report (December 2020).

Table 32. OSR reports

OSR report Description Further information
OSRCSs1 How many episodes of health carewere | CS-1 (on page 55)
provided by your health service during
year?
OSR CS-2 How many client contacts were made CS-2 (on page 55)

by each type of worker from the service
during the year?

OSR CS-3 How many individual clientswereseen | CS-3 (on page 58)
by your health service during the period?
OSR CS4 How many Adult Health Checks and CS-4 (on page 59)

Chronic Disease Management Plans were
done during the year?

OSR HP-1 How many health promotion group HP-1 (on page 59)
activities were run during the year?

OSRL-6 How many clients were seen by the Link | L-6 (on page 60)
Up Service during the year?

OSR L-7 How many client contacts were provided | L-7 (on page 60)
by the Link Up service during the year?

OSR MCH-1 How many Child Health Checks were MCH-1 (on page 60)
done during the year?

OSR MCH-2 How many individual mothers have MCH-2 (on page 61)
attended routine antenatal care during the
year?

OSR MCH-3 How many antenatal and maternal group | MCH-3 (on page 61)
activities were run during the year?

OSR S6 How many distinct individua clients S-6 (on page 62)
were seen by your organisation during
the year?

OSR S-7a How many distinct individual S-7a(on page 62)

clients received residential
treatment/rehabilitation at your
organisation during the year?

OSR S7b What was the total length of stay for each | S-7b (on page 63)
of your clientsin residential treatment /
rehabilitation during the year?

OSR S7c How many residential S-7c (on page 63)
treatment/rehabilitation episodes of care
were provided by your service during the
year?

OSR S10 How many distinct clients attended S-10 (on page 64)
your sobering-up and/or residential
respite/short term care programs during
the year?

OSR §11 How many 'sobering up/residential S-11 (on page 64)
respite/short-term' episodes of care were
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Table 32. OSR reports (continued)

OSR report Description Further information
provided by your service during the
year?
OSR $13 How many individual clients received S-13 (on page 65)

'non-residential/follow up / after care'
from your organisation during the year?

OSR S14 How many 'non-residential/follow up / S-14 (on page 65)
after care' episodes of care were provided
by your service during the year?

OSR SE-6 How many individual clientswere seen | SE-6 (on page 66)
by SEWB Counsellors during the year?
OSR SE-7 How many client contacts were made by | SE-7 (on page 66)
SEWB Counsellors during the year?
OSR HCP Health Care Provider (HCP) report Included in Communicare VV18.1 and

laterHCP (on page 67)

OSR CS-1a- Episodes of care
Number of episodes of care provided within the previous 12 months.
Description

The report counts all services except:

*Anyno client contact service.

» The contact service of Admi ni stration - client contact.

* Wi ti ng, Booked or Cancel | ed services.

* Services provided by providers with aspeciality of t ransport wor ker .
* Servicesrecorded using the Tr anspor t module.

* Services recorded for fictitious clients.

If there are multiple services recorded on the same day, only one is counted for this report.

Table 33. OSR CS-01

Element Description
Communicare reports * Report > OSR > CS-01 Episodes of Health Care
Businessrules Described above.

Additional datarecording 5 . o
considerations Pl Note: Currently thereis no distinction between the encounter place or contact

types for multiple services recorded on the same day.

OSR CS-2 - Client contacts

How many client contacts were made by each type of worker from the service during the year?

Description

The report counts all services except:
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*Anyno client contact service
* Wi ti ng, Booked or Cancel | ed services.
« Servicesrecorded for fictitious clients.

Services recorded in either the Transport Managenent or Transport Servi ces module are also

included.

Table 34. OSR CS-02

Element

Description

Communicare reports

* Report > OSR > CS-02 Contacts by Worker Type

Business rules

For information about how Communicare speciality types are mapped, see Client
Contact Types reference (on page 28)

See the tables below for specific reverse mappings.

Additional datarecording
considerations

A provider who is part of a service does not need to have recorded any clinical
information to be included. This means that a claiming doctor who is added to a contact
service for the purposes of making aMedicare claim only isincluded in this report.

OSR to Communicar e rever se mappings

Table 35. Main contact types

OSR contact type

Communicare Speciality

Aborigina and Torres Strait |slander Health
Worker (ATSIHW)

ABORIGINAL AND TORRES STRAIT ISLANDER HEALTH
WORKER, ABORIGINAL FAMILY HEALTH WORKER

Aboriginal and Torres Strait Islander Health
Worker Practitioner

ABORIGINAL AND TORRES STRAIT ISLANDER HEALTH
PRACTITIONER

Dental support (e.g. dental assistant / dental
technician)

DENTAL - TECHNICIAN OR PROSTHETIST, DENTAL
ASSISTANT, DENTAL PROSTHETIST, DENTAL TECHNICIAN

Dentists/ dental therapists

DENTAL HYGIENIST, DENTAL SPECIALIST, DENTAL
THERAPIST, DENTIST

Doctor - General Practitioner

GENERAL MEDICAL PRACTITIONER

Midwives

MIDWIFE

Nurses

CHILD HEALTH NURSE, ENROLLED NURSE, ENROLLED

NURSE (MENTAL HEALTH), MOTHERCRAFT NURSE, NURSE
EDUCATOR, NURSE MANAGER, NURSE PRACTITIONER, NURSE
RESEARCHER, REGISTERED NURSE, REGISTERED NURSE
(DEVTL DISABILITY),REGISTERED NURSE (MENTAL HEALTH)

Other health / clinical staff

ABORIGINAL AND TORRES STRAIT ISLANDER LIAISON
OFFICER, ABORIGINAL COMMUNITY SUPPORT WORKER,
AMBULANCE OFFICER, ASSISTANT IN NURSING,
CHILDCARE WORKER, CLERICAL / ADMINISTRATIVE
WORKER, CLINICAL ALLERGIST, COMMUNITY / FAMILY
REPRESENTATIVE, COMMUNITY SERVICES WORKER, DAY
CARE WORKER, EPIDEMIOLOGIST, HEALTH INFORMATION
MANAGER, HEALTH PRACTICE MANAGER, HEALTH
PROMOTION OFFICER, HOME HELP WORKER, HOSPITAL
SCIENTIST, INTERPRETER/TRANSLATOR, MEALS/FOOD
SERVICES WORKER, MEDICAL INTERN, MEDICAL
PRACTITIONER IN TRAINING, MEDICAL RECEPTIONIST,
OTHER PROFESSION/DISCIPLINE, PHARMACY TECHNICIAN,
PHLEBOTOMIST, PHY SICIAN'S ASSISTANT, RECREATION
WORKER, REGISTERED PARAMEDIC, RESIDENT MEDICAL
OFFICER, SONOGRAPHER, TECHNICIAN, THERAPIST'S
ASSISTANT, THERAPY AIDE, VOLUNTARY WORKER
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Table 35. Main contact types (continued)

OSR contact type

Communicare Speciality

Sexual health worker

SEXUAL HEALTH WORKER

Substance misuse / drug and a cohol worker

DRUG AND ALCOHOL COUNSELLOR, SUBSTANCE MISUSE
WORKER

Tobacco worker / coordinator

SMOKING CESSATION COORDINATOR, SMOKING CESSATION
OFFICER

Traditional healer

TRADITIONAL HEALER

Transport worker

TRANSPORT WORKER

Table 36. Medical specialists

OSR specialist type

Communicare Speciality

Cardiologist

CARDIOLOGIST

Dermatologist

DERMATOLOGIST

Ear Nose and Throat Specialist

EAR, NOSE AND THROAT SPECIALIST

Endocrinologist

ENDOCRINOLOGIST

Obstetrician / Gynaecol ogist

OBSTETRICIAN AND GYNAECOLOGIST

Ophthalmol ogist OPHTHALMOLOGIST
Paediatrician PAEDIATRICIAN
Psychiatrist/Psychiatric Register PSYCHIATRIST

Renal Medicine Specialist

RENAL MEDICINE SPECIALIST

Specialist other or not specified

ANAESTHETIST, CLINICAL CYTOPATHOLOGIST,

CLINICAL HAEMATOLOGIST, CLINICAL

PHARMACOLOGIST, EMERGENCY MEDICINE SPECIALIST,
GASTROENTEROLOGIST, GERIATRICIAN, GYNAECOLOGICAL
ONCOLOGIST, IMMUNOLOGIST, INFECTIOUS DISEASES
PHYSICIAN, INFECTIOUS DISEASES SPECIALIST, INTENSIVE
CARE ANAESTHETIST, INTENSIVE CARE MEDICINE
SPECIALIST, MEDICAL DIAGNOSTIC RADIOGRAPHER,
MEDICAL ONCOLOGIST, NEPHROLOGIST, NEUROLOGIST,
NEUROSURGEON, NUCLEAR MEDICINE TECHNOLOGIST,
ORAL AND MAXILLOFACIAL SURGEON, ORTHOPAEDIC
SURGEON, ORTHOPTIST, PALLIATIVE MEDICINE PHY SICIAN,
PATHOLOGIST, PLASTIC AND RECONSTRUCTIVE SURGEON,
PUBLIC HEALTH PHYSICIAN, RADIATION ONCOLOGIST,
RADIOLOGIST, RADIOTHERAPIST, RESPIRATORY PHY SICIAN,
RHEUMATOLOGIST, SEXUAL HEALTH PHYSICIAN,
SPECIALIST MEDICAL PRACTITIONER, SPECIALIST
PHYSICIAN, UROLOGIST, VETERINARIAN

Surgeon

CARDIOTHORACIC SURGEON, SURGEON, VASCULAR
SURGEON

Table 37. Social and emotional wellbeing / Counsellors

OSR specialist type

Communicar e Speciality

Counsellor

BTH COUNSELLOR, COUNSELLOR

Psychologist

CLINICAL PSYCHOLOGIST, PSYCHOLOGIST,
NEUROPSY CHOLOGIST

SEWB staff other or not specified

ABORIGINAL MENTAL HEALTH WORKER, EMOTIONAL AND
SOCIAL WELLBEING STAFF, PSYCHOTHERAPIST, TEAM.
PSYCHOGERIATRIC ASSESS TEAM (PGAT), YOUTH WORKER
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Table 37. Social and emotional wellbeing / Counsellors (continued)

OSR specialist type

Communicar e Speciality

Social Worker

SOCIAL WORKER

Welfare Worker

WELFARE WORKER

Table 38. Allied health professionals

OSR specialist type

Communicar e Speciality

Allied health other or not specified

ACUPUNCTURIST, ALLIED HEALTH AIDE, ALTERNATIVE
THERAPIST, ASTHMA EDUCATOR, ATTENDANT CARER,
CARDIAC EDUCATOR, CHIROPRACTOR, CHRONIC

CARE COORDINATOR, COMMUNITY PARAMEDICAL,
DERMAL CLINICIAN, DISABILITY SERVICES WORKER,
ENVIRONMENTAL HEALTH OFFICER, EXERCISE
PHYSIOLOGIST, EYE HEALTH COORDINATOR, HEALTH
DIAGNOSISTREATMENT PRACTITIONER, HOME CARE
WORKER, HOMOEOPATH, MASSAGE THERAPIST, MUSIC
THERAPIST, NATURAL THERAPY PROFESSIONAL,
NATUROPATH, OCCUPATIONAL THERAPIST, ORTHOTIC
PROSTHETIST, ORTHOTIST, OSTEOPATH, PERSONAL CARE
ASSISTANT, PHYSIOLOGIST, REHABILITATION AIDE,
TEAM. AGED CARE ASSESSMENT TEAM (ACAT), TEAM.
MULTI-DISCIPLINARY TEAM

Diabetes educator

DIABETES EDUCATOR

Dietician DIETITIAN

Optometrist OPTOMETRIST

Pharmacist PHARMACIST

Physiotherapist PHYSIOTHERAPIST, CARDIOTHORACIC PHY SIOTHERAPIST,
RESPIRATORY PHY SIOTHERAPIST

Podiatrist PODIATRIST

Speech Pathol ogist SPEECH PATHOLOGIST, SPEECH THERAPIST

OSR CS-3a- Individual clients seen

How many Adult Health Checks and Chronic Disease Management Plans were done during the year?

Description

The report counts al clients who had services except the following and services recorded for fictitious clients.:

*Anyno client contact service.

* Wi ti ng, Booked or Cancel | ed services.

Table 39. OSR CS-03

Element Description
Communicare reports » Report > OSR > CS-04 Clinical Activities
Businessrules This report counts individuals who are included at least once in CS-2 (on page 55).
Additional datarecording none
considerations
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OSR CS4 - Clinical Services CS-4 Record the count for the following clinical
activities carried out during the Financial Y ear

How many Adult Health Checks and Chronic Disease Management Plans were done during the year?

Description

Health checks are identified either by Medicare claims for item 715 or alternatively by clinical items with the
system code of CHC (Child Health Check), AHC (Adult Health Check) and OHC (Older person Health Check).
If botha MBS 715 and an aternative health check are recorded for the same patient, only the 715 check is
counted.

Chronic disease management plans are identified either by Medicare claims for item 721 or aternatively by
clinical items with the system code of CPA. If both aMBS 721 and any clinical items with system code CPA
are recorded for the same patient, only the 721 plan is counted.

Note: Because the claim and the evidence of the claim can be recorded on separate occasions, and
because items 715 and 721 are usually annual claims, individual patients rather than individual claims
or completed clinical items are reported .

Table 40. OSR CS-04

Element Description
Communicare reports * Report > OSR > CS-04 Clinical Activities
Business rules Evidence of claims for items 715 and 721 is searched for and if none is found, the

clinical items are searched using the system codes of CHC, AHC, OHC and CPA.

Additional datarecording none
considerations

OSR HP1 - Health Promotion HP-1 How many group activities and popul ation
health promotional activities has your organisation run during the Financial Y ear?

How many health promotion group activities were run during the year?
Description

The report counts procedures with an export code starting HP- GRP, analysed by day and encounter placein
order to deduce the number of group sessions conducted, assuming that the same type of session isnot run
repeatedly on the same day at the same place.

For detailed information about export codes, see Procedure, |mmunisation, Pathology & Medicare codes
reference (on page 24).

Table 41. OSR HP-1

Element Description
Communicare reports * Report > OSR > HP-01 HP Group Activities
Businessrules All clinical items with appropriate codes recorded in any patient record are deemed

to be evidence of attendance at a group health promotion event. Actual attendance is
not counted so where a non-patient record is used to record anonymous attendance, the
event is still recorded.

Additional data recording No clinical items with these codes are distributed by Communicare so all data
considerations collection for thisindicator is done using locally defined procedures.
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OSR L-6 - Link Up L-6 How many individual clients were seen by SEWB funded
counsellors during the Financia Year?

How many clients were seen by the Link Up Service during the year?

Description

Link-up service contacts are identified by encounter place names which contain the words BTH or Li nk Up or
encounter program names which contain the words BTH, Li nk Up or Bri ngi ng Them Hone.

Table 42. OSR L-6

Element Description
Communicare reports * Report > OSR > L-06 Individual Link Up Clients
Businessrules Any patient with at least one contact service recorded during the report period at aBTH
or Link Up encounter place or recorded with the associated BTH or Link Up encounter
program.
Additional data recording none
considerations

OSR L-7 - Link Up L-7 How many client contacts were provided by the Link Up
organisation during the Financial Y ear?

How many client contacts were provided by the Link Up service during the year?

Description

Link-up service contacts are identified by encounter place names which contain the words BTH or Li nk Up or
encounter program names which contain the words BTH, Li nk Up or Bri ngi ng Them Hone.

Table 43. OSR L-7

Element Description
Communicare reports * Report > OSR > L-07 Link Up Contacts
Businessrules All contact services recorded during the report period at aBTH or Link Up encounter

place or recorded with the associated BTH or Link Up encounter program.

Additional data recording none
considerations

OSR MCH-1 - Maternal and Child Health MCH-1 Record the number of child
health checks conducted in the Financial Y ear

How many Child Health Checks were done during the year?
Description

Health checks are identified by the client being 0 to 4 years of age and either a Medicare claimed for item
715 or alternatively by clinical item with the system code of CHC. If both aMBS 715 and an alternative health
check (CHC) are recorded for the same patient, only the 715 check is counted.

Note: Because the claim and the evidence of the claim can be recorded on separate occasions, and
because item 715 is usually an annual claim, individual patients are reported rather than individual
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)y Claimsor completed clinical items. MBS item 10986 Healthy Kids Check are identified by Medicare
(d claimsfor item 10986.

Table 44. OSR MCH-1

Element Description
Communicare reports * Report > OSR > MCH-01 Child Health Checks
Business rules This report counts individual s with evidence of an annual child health check during the

report period. A patient with two such checksis reported once only.

Additional datarecording Medicare Item 10986 is ho longer available.
considerations

OSR MCH-2 - Maternal and Child Health MCH-2 Record the number of individual
mothers who have attended a routine antenatal care conducted by your organisation
during the Financial Y ear

How many individual mothers have attended routine antenatal care during the year?

Description

Antenatal checks are identified by procedures with a PR- CHECK rule code; that is, al those itemslisted on the
Obstetrics tab, Antenatal Check.

Table 45. OSR MCH-2

Element Description
Communicare reports * Report > OSR > MCH-02 Individual Antenatal Care Clients
Businessrules Any woman with an antenatal check performed during the report period isincluded.

For details of how to record an antenatal check, see Procedure, Immunisation,
Pathology & Medicare codes reference (on page 24).

Note: If the response to the qualifier Ant enat al check perfornedis
anything starting with El sewher e...the check isignored. That is, if the
responseisAt this encounter place orthereisno response, the check is
counted.

Additional data recording none
considerations

OSR MCH-3 - Maternal and Child Health MCH-3 Record whether your organisation
ran the following antenatal and maternal group activities during the Financial Y ear

How many antenatal and maternal group activities were run during the year?
Description
Where possible, record the number of sessions run.

The report counts procedures with an export code starting MCH GRP, analysed by day and encounter placein
order to deduce the number of group sessions conducted, assuming that the same type of session isnot run
repeatedly on the same day at the same place.
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For details about export codes, see Procedure, Immunisation, Pathology & Medicare codes reference (on page
24).

Table 46. OSR MCH-3

Element Description
Communicare reports * Report > OSR > MCH-03 MCH Group Activities
Businessrules All clinical items with appropriate codes recorded in any patient record is deemed

to be evidence of attendance at a maternal and child health group health promotion
event. Actua attendance is not counted so where a non-patient record is used to record
anonymous attendance, the event is still recorded.

Additional data recording No clinical items with these codes are distributed by Communicare so al data
considerations collection for thisindicator is done using locally defined procedures.

OSR S-6 - Standalone Substance Use S-6 How many distinct individual clients were
seen by your organisation during the Financial Y ear?

How many distinct individual clients were seen by your organisation during the year?

Description

The report counts all clients who had services (except: 'no client contact' services; 'waiting', 'booked' or
‘cancelled’ services) and services recorded for fictitious clients, who satisfy at least one of the following
criteria

» Werereceiving residential drug and alcohol care during part or all of the reporting period.

+ Had received some 'sobering up/residential respite/short-term' episodes of care during part of the
reporting period.

* Received a service associated with an encounter program containing the words 'DRUG' and/or
'‘ALCOHOL" and/or 'AQD".

* Received a service associated with an encounter place containing the words 'DRUG' and/or
'ALCOHOL" and/or 'AQD".

* Received a service provided by a'Drug and alcohol counsellor' or a'Substance misuse worker'.

* Received a service having at least one procedure or referral that is not arecall or a cancelled recall
having a keyword containing the words 'DRUG' and/or 'ALCOHOL ' and/or ‘AQOD".

Table 47. OSR S-6

Element Description
Communicare reports * Report > OSR > S-06 Individual Clients
Businessrules The description above details which services are counted as substance use services.
Additional datarecording Thisindicator wasinitially specified for standalone substance use services only but has
considerations since been extended to mainstream health services who receive funding for substance
use support. Assuch it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of thistype.

OSR S-7a - Standalone Substance Use S-7a How many distinct individual clients
received residential treatment / rehabilitation at your organisation during the
Financial Year?

How many distinct individual clients received residential treatment/rehabilitation at your organisation during
the year?
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Description

Residential treatment isidentified by enrolments. Enrolments are identified by export code DA- ENRCL with
aTreatment delivery setting qualifier (DA- TDS export code) set to Resi dent i al Tr eat ment

Facility.

Enrolments recorded for fictitious clients are not included.

Table48. OSR S-7a

Element

Description

Communicare reports

* Report > OSR > S-07 Individual Rehabilitation Clients

Business rules

The acohol and other drug dataset distributed by Communicare includes items with the
appropriate codes to record the start and end of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Additional datarecording
considerations

The Communicare report numbering dates from an earlier numbering system for OSR
reporting — report 7 now reports for indicator 7a.

OSR S-7b - Standal one Substance Use S-7b What was the total length of stay for
each of your clientsin residential treatment / rehabilitation during the Financial

Y ear?

What was the total length of stay for each of your clientsin residential treatment / rehabilitation during the

year?

Description

Residential treatment is identified by enrolments. Enrolments are identified by export code DA- ENROL with
aTreatment delivery setting qualifier (DA- TDS export code) set to Resi dent i al Tr eat ment

Facility.

Enrolments recorded for fictitious clients are not included.

Table49. OSR S-7b

Element

Description

Communicare reports

* Report > OSR > S-07a Length of Stay

Business rules

The alcohol and other drug dataset distributed by Communicare includes items with the
appropriate codes to record the start and end of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Additional data recording
considerations

The Communicare report numbering dates from an earlier numbering system for OSR
reporting — report 7a now reports for indicator 7b.

OSR S-7¢ - Standalone Substance Use S-7¢c How many residential treatment /
rehabilitation episodes of care were provided by your organisation during the

Financial Year?

How many residential treatment/rehabilitation episodes of care were provided by your service during the

year?
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Description

Residential treatment isidentified by enrolments. Enrolments are identified by export code DA- ENRCL with
aTreatment delivery setting qualifier (DA- TDS export code) set to Resi dent i al Tr eat ment
Facility.

Enrolments recorded for fictitious clients are not included.

Table 50. OSR S-7c

Element Description
Communicare reports * Report > OSR > S-07b Residential Episodes
Businessrules The alcohol and other drug dataset distributed by Communicare includes items with the

appropriate codes to record the start and end of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Additional datarecording The Communicare report numbering dates from an earlier numbering system for OSR
considerations reporting — report 7b now reports for indicator 7c.

OSR S-10 - Standalone Substance Use S-10 How many distinct clients attended your
sobering-up and/or residential respite/short term care programs during the Financial
Year?

How many distinct clients attended your sobering-up and/or residential respite/short term care programs
during the year?

Description

Sobering-up and/or Residential Respite/Short-term care episodes are identified by clinical items with export
codes of DR- ENROL and DA- SUCS.

Table51. OSR S-10

Element Description
Communicare reports * Report > OSR > S-10 Individual Non-Rehab Clients
Businessrules The alcohol and other drug dataset distributed by Communicare includes items with the

appropriate codes to record the start and end of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Additional datarecording none
considerations

OSR S$-11 - Standalone Substance Use S-11 How many 'sobering up / residential
respite / short-term' episodes of care were provided by your organisation during the
Financial Year?

How many 'sobering up/residential respite/short-term' episodes of care were provided by your service during
the year?

Description

Sobering-up and/or Residential Respite/Short-term care episodes are identified by clinical items with export
codes of DR- ENROL and DA- SUCS.
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Table52. OSR S-11

Element Description
Communicare reports * Report > OSR > S-11 Episodes Non-Rehab Clients
Businessrules The acohol and other drug dataset distributed by Communicare includes items with the

appropriate codes to record the start and end of periods of treatment.

For details about codes, see Procedure, Immunisation, Pathology & Medicare codes
reference (on page 24).

Additional data recording none
considerations

OSR S$-13 - Standalone Substance Use S-13 How many individual clients received
'non-residential / follow up / after care' from your organisation during the Financial
Year?

How many individual clients received 'non-residential/follow up / after care’ from your organisation during the
year?

Description

The report counts all clients who had services (except: 'no client contact' services; 'waiting', 'booked' or
‘cancelled' services) and services recorded for fictitious clients, who satisfy at least one of the following
criteria

* Received a service associated with an encounter program containing the words 'DRUG' and/or
'ALCOHOL" and/or 'AOD".

* Received a service associated with an encounter place containing the words 'DRUG' and/or
'ALCOHOL" and/or 'AQD".

» Received a service provided by a'Drug and alcohol counsellor' or a'Substance misuse worker'.

» Received aservice having at least one procedure or referral that is not arecall or a cancelled recall
having a keyword containing the words 'DRUG' and/or 'ALCOHOL" and/or 'AQD".

Excluded are services where the client was receiving residential drug and alcohol care at that time or attended
agroup session or was receiving 'sobering up/residential respite/short-term' care as a part of that service.

Table 53. OSR S-13

Element Description
Communicare reports * Report > OSR > S-13 Individual Non-Residential Clients
Businessrules The description above details which services are counted as substance use services.
Additional datarecording Thisindicator wasinitially specified for standalone substance use services only but has
considerations since been extended to mainstream health services who receive funding for substance
use support. Assuch it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of thistype.

OSR $-14 - Standalone Substance Use S-14 How many 'non-residential / follow up /
after care' episodes of care were provided by your organisation during the Financial
Year?

How many 'non-residential/follow up / after care’ episodes of care were provided by your service during the
year?
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Description

The report counts all clients who had services (except: 'no client contact' services; 'waiting', 'booked' or
‘cancelled’ services) and services recorded for fictitious clients, who satisfy at |east one of the following
criteria

* Received a service associated with an encounter program containing the words 'DRUG' and/or
'ALCOHOL" and/or 'AOD".

* Received a service associated with an encounter place containing the words 'DRUG' and/or
'ALCOHOL" and/or 'AQD".

» Received a service provided by a'Drug and alcohol counsellor' or a'Substance misuse worker'.

» Received aservice having at least one procedure or referral that is not arecall or a cancelled recall
having a keyword containing the words 'DRUG' and/or 'ALCOHOL " and/or 'AQD".

Excluded are services where the client was receiving residential drug and alcohol care at that time or attended
agroup session or was receiving 'sobering up/residential respite/short-term' care as a part of that service.

Table54. OSR S-14

Element Description
Communicare reports * Report > OSR > S-14 Episodes of Non-Residential Care
Businessrules The description above details which services are counted as substance use services.
Additional datarecording Thisindicator wasinitialy specified for standalone substance use services only but has
considerations since been extended to mainstream health services who receive funding for substance
use support. As such it is not yet clearly defined but the above conditions are fairly
comprehensive although they may over-report activity of thistype.

OSR SE-6 - Social and Emotional Wellbeing SE-6 How many individual clients
were seen by SEWB funded counsellors during the Financial Y ear?

How many individual clients were seen by SEWB Counsellors during the year?

Description

SEWB contacts are identified by the provider's specialty being either BTH Counsel | or or Counsel | or .

Table 55. OSR SE-6

Element Description
Communicare reports * Report > OSR > SE-06 I ndividual SEWB Clients
Businessrules Patients with at |east one service recorded in the report period with a BTH Counsellor

or Counsellor are counted once only.

Additional data recording none
considerations

OSR SE-7 - Social and Emotional Wellbeing SE-7 How many client contacts were
provided by the SEWB funded counsellors during the Financial Y ear?

How many client contacts were made by SEWB Counsellors during the year?

Description

SEWB contacts are identified by the provider's speciaty being either BTH Counsel | or or Counsel | or .
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Table 56. OSR SE-7

Element Description
Communicare reports * Report > OSR > SE-07 SEWB Contacts
Businessrules All services recorded in the report period with a BTH Counsellor or Counsellor are
counted.
Additional data recording none
considerations

OSR HCP Health Care Provider (HCP) report
Health Care Provider (HCP) report
Description

The Health Care Provider (HCP) report refers to the report submitted annually to the Department of Health by
al Australian Government funded Indigenous health services who are eligible to claim Medicare benefits for
primary health care services.

Thisreport shows al providers that have a DOH Provider Number who were enabled for all or part of the
reporting period.

Table 57. OSR HCP

Element Description
Communicare reports * Report > Health Care Providers> Provider List
Businessrules All providers recorded in File> Provider who have at least one DOH Provider number

and who were not disabled before the start of the report period nor only enabled after
the end of the report period.

Additional datarecording none
considerations

NSW KPIs

Additiona information for NSW KPIs.

Beforeyou start
Note: Configuration notes are valid for the Version 5.0 of the NSW KPI reports.

If your health service is using Communicare ‘out of the box’ and has taken advantage of datasets provided by
Communicare, only the codes highlighted here need to be considered.

Note: For best results when reporting, use the datasets provided by Communicare rather than creating
your own.
Clinical items

This section identifies any loca clinical items that may be evidence of procedures and other activity required
for specific indicators.
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Configuration is done at File > Reference Tables> Clinical Item Types.

Table 58. Required clinical items

Perfor mance indicator

For

Description

Smoking Cessation

» Any procedure or referral which is evidence of
smoking cessation must use the system code SCS

» Any procedure or referral performed whichisin the
Tobacco use services

Immunisation Types

Influenza

Communicare supports the Generic Influenza AIR vaccine,
with vaccine code GNFL U, and its equivalents described in
Equivaent and partial equivaent vaccines table - GNFLU
entry. For example, GNFLU, PANVAX, FLUVAX, and so
on.

Pertussis

The following export codes identify pertussis vaccines:
ADCL, ADPO, BOOST or BOIPV.

If you do not make Medicare claims, make sure that clinical items used to record care plans and health checks
use the following system codes.

Qualifiers

This section identifies any local qualifiers that may be evidence of details required for specific indicators.

Configuration isdone at File > Reference Tables > Qualifier Types.

Table 59. Required qualifiers

Performance indicator

Code

Description

Smoking Cessation

BI P

Any clinical item that is evidence of ‘brief intervention” should
have aqudifier that is either:

* A Yes/No qualifier with a system code of BI P
* A reference qualifier where relevant responses have
system codes of BI P.

Smoking Status

SMO or SMP

The central qualifiers are appropriately coded, but if alocal
variation is used the qualifier itself must be areference qualifier
with the system code SMo or SVP (if recorded during a pregnancy).

Each reference must be coded in the following way:

 System Codes:
° S - current smoker
° E - ex-smoker
> N - never smoked
* For export code SMo:
o 1 - wantsto quit now
o 2 - wantsto quit later
> 3 - no intention of quitting
o 4 - quit less than 12 months ago
o 5- quit 12 months or more ago
o 7 = non-smoker
* For export code SvP:
o 1 - daily smoker
o 2 - weekly smoker
o 3 - irregular smoker
° 4 - quit during pregnancy
° 5 - quit before pregnancy
° 6 - non-smoker
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Table 59. Required qualifiers (continued)

Performance indicator

Code

Description

Central pathology
qualifiers

BPS, CHO, CHR, HDL,
CVR- RO5C, CVR- ROSF,
ACR, GFE, HBA, HBM
AUDI TC, XHB, XHC, XCL,
XGN, XSY, XHI

Only of interest if the health service has local equivalents:

« Systolic blood pressure is determined as the latest qualifier
with system code BPS

* Total cholesterol is determined as the latest qualifier with
system code CHOor CHR

+ High density lipoprotein is determined as the latest
qualifier with system code HDL or CHR

» CVD risk assessment is determined as the latest qualifier
with export code CVR- RO5C

* (CARPA) or CVR- RO5F (Framingham).

* Urinary Albumin Creatinine Ratio is determined as the
latest qualifier with system code ACR.

+ Estimated Glomerular Filtration Rate is determined as the
latest qualifier with system code GFE.

* HbA1c is derived from numeric qualifiers with a system
code of HBA and units % or HBMand units mmol/mol
converted to percentage.

* AUDIT-C Score is determined by numeric qualifiers with
an export code of AUDI TC.

* Hepatitis B result abnormal yes/no qualifier (system
code xHB). The qualifier must be set to Y esto be counted.

e Hepatitis C result abnormal yes/no qualifier (system
code XHC). The qualifier must be set to Y esto be counted.

* Chl anydi a result abnormal yes/no qualifier (system
code XcL). The qualifier must be set to Y es to be counted.

* Gonorrhoea result abnormal yes/no qualifier (system
code XGN). The qualifier must be set to Y es to be counted.

* Syphilis result abnormal yesno qualifier (system
code XSY). The qualifier must be set to Y esto be counted.

*HV result abnormal yes/no qualifier (system code
XHI ). The qualifier must be set to Y esto be counted.

I nvestigation Requests

This section identifies keywords that need to be attached to any of your investigation request termsto identify
them as ST test requests.

Configurationisdone at File > Reference Tables > | nvestigations > I nvestigation Keywords.

ST request terms

Table 60. STI request terms

I nfection keyword
Hepatitis B HepB
HBV DNA Viral load test HBV
HCV RNA test HVCRNA
Chlamydia CHLAMYDIA
Gonorrhoea GONORRHOEA
Syphilis SYPHILIS
HIV HIV

Liver Function Tests
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Liver Function Tests are determined from Pathol ogy test requests that have a keyword of LFT.

Central and imported codes

This section refersto codes that are attached to ICPC2-Plus items, MIM S medications, incoming pathol ogy
results (LOINCs), and so on. Some labs use their own local codes to identify pathology results and use of

LOINCs for text-based results is not consistent.

Table 61. Central & imported codes

Database

Report

Description

MIMS

Smoking Cessation

M edications with an indication containing the text smok or
nicotine are identified as smoking cessation treatments. For
example, the drug Champix isincluded because it has an
indication of Nicotine dependence.

CVD Risk Treatment

Medications with an indication of hyperlipidaemia,
hyper cholester olaemia or hypertension are identified
as smoking cessation treatments. For example, the drug
Cleviprex isincluded because it has an indication of
Hypertension.

DAA Treatment

Recent prescriptions are identified by the following generic
components. pegylated interferon, daclatasvir, sofosbuvir +
ledipasvir, ribavirin, sofosbuvir, paritaprevir + ritonavir +
ombitasvir + dasabuvir, paritaprevir + ritonavir + ombitasvir
+ dasabuvir + ribavirin.

LOINC

Incoming pathology results are identified by LOINCs
(if supplied by the lab) for the specified STI. For more
information, see https://loinc.org/. Additionally, if only
positive results are reported, the lab must return an
abnormal code.

ICPC Diagnoses

Specific conditions for specific indicators are identified

in the NSW specifications document Aboriginal Health
Program Key Performance Indicators: Data Specifications
2019/20-2021/22 Version 5.0 February 2021

NT KPIs

Additiona information for NT KPIs.

Before you start

Note: For best results when reporting, use the datasets provided by Communicare rather than creating

your own.

Before you can effectively use the NT KPIs you need to configure parts of your database.

Encounter place

Configure your encounter places:

1. Select File > Reference Tables> Encounter Place.
2. If you have only one clinic:
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a From the L ocality Group list, select Heal t h Servi ce Area.
b. Inthe DHF Health Service Code field, enter the five digit code allocated by the Department of
Health and Families.

3. If you have multiple clinics, each encounter place must be allocated a unique locality group that defines
the localities covered by that encounter place. Ideally all localitiesin the Health Service Areawill
be alocated to asingle smaller locality group that will be allocated to a single encounter place. Each
encounter place must also be given the appropriate DHF Health Service Code.

Tip: To help you edit or create these groups, run the report Report > Reference Tables >
Locality Group Analysis. Enter arange of post codes that covers your Health Service Area
and the report will show you which localities belong to which locality group.

Data requirements

Review the data collection requirements. Check the Healthy for Life (on page ) reports - many of the
indicators are comparabl e to those defined for Healthy for Life.

Further data collection regquirements include:

» Anaemic children are identified by their latest qualifier Hb (Haemoglobin) recorded during the
reporting period being lessthan 110 g/L (lessthan 105 g/L if under 12 months old).
* Patients with albuminuria are defined as having a latest qualifier ACR (Alb/Creat Ratio) recorded
during the reporting period as being greater than 3.4.
» Patients are recognised as being on an ACE inhibitor, or ARB drug by checking their regular and
current medications as selected from the appropriate ATC (Anatomical Therapeutic Chemical) codes.
» PAP smears are counted by looking for investigation requests for tests whose description starts with
PAP smear (caseinsensitive) or for clinical items with the export code PAPSM EAR.
« If you do not make Medicare claims then you will need to make sure that clinical items used to record
care plans and health checks have the following system codes:
o GP management plan items must use CPA
o Team care arrangements must use TCA
o Adult health checks must use AHC
o Child health checks must use CHC
o Elderly health checks must use OHC
* Clients are assumed to be fully immunised if they have no overdue recalls for immunisations
(excluding Panvax and Fluvax) or immunisation reviews that were due before the reference
date or have an appropriate completed review. Immunisation review items should start
Revi ew; i mmuni sat i on; followed by the age, for example, Revi ew; i muni sati on; 2 nont hs
age

Running the NT Aboriginal Health Key Performance Indicators (NT
KPI) reports

Run the NT KPI reports from Report > NT KPI. Run each individual report to show datafor each KPI.
The data export fileis created at Report > NT KPI > AHKPI Data Export.

A summary view of the data export fileis available at Report > NT KPI > AHKPI Data Export Summary.

PJ Note Reports adhere to NT Aboriginal Health Key Performance Indicators, Definitions, October
2013, Version 2.0.4.
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Included data
Because datais disaggregated by age, patients with no date of birth will not be included.

For KPI 1.2 to 1.15, only patients who have a patient status of Cur r ent at the end of the reporting period are
considered.
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Support

If you run into problems using Communicare, you can always get help from us.

For information about Communicare, visit the Communicare User Portal. If you need more help, go the
Communicare User Portal - Help and Support tab.

If you still need help, create a support request and we'll get back to you.

Include as much information in the request as you can and follow these guidelines:

« If you include patient information, for patient confidentiality, use the Patient ID instead of the patient’s
name.
« If you include screenshots, ensure that you conceal both the patient’ s name and date-of-birth.

4 Fastpath: For urgent problems or issues with using the portal, call 1800 798 441 to speak to a
support team member.

If reporting a problem, before contacting us, try to replicate the problem. It also helps to write down the
problem and the circumstances under which it occurred.

Release Notes

Release notes for all versions of Communicare are available on the Knowledge Centre.

To open the release notes for the latest version of Communicare:

1. On the Communicare User Portal > Help and Support https://communicare-portal .tel straheal th.com/
hel p-and-support/ tab, in the Knowledge Centretile, click Learn More.

2. In the Knowledge Centre https://communi care-portal .tel straheal th.com/knowledge/, from the main
menu, select Support > Release Notes > required release notes version.

0 Tip: Release notes for the latest version are listed first.

If you are using an older version of Communicare and want to refer to release notes for that version, the
release notes are included with the latest version. However, to display the Knowledge Centre for your
version of Communicare, in the Knowledge Centre, on the right side of the main menu, select your version of
Communicare.

Support PDFs on

i & vl =

Cusreent (V1.2

L roa g

(c)Telstra Health | Communicare 73


https://communicare-portal.telstrahealth.com/
https://communicare-portal.telstrahealth.com/help-and-support/
https://www.bit.ly/communicarehelp
https://communicare-portal.telstrahealth.com/help-and-support/
https://communicare-portal.telstrahealth.com/knowledge/
https://communicare-portal.telstrahealth.com/knowledge/

Quick linksto release notes

« Version 21.x:
0o \V21.3
°oV21.2
°oV21.1

« Version 20.x
> V20.2

« Version 19.x
°V19.2
°V19.1

« Older versions

Training

If you want someone to teach you how to use Communicare, from beginners to advanced users, try our
training.

We can organise someone to come to you, or you can access our eLearning.

0 Tip: Check our eLearning site regularly for our invaluable Tips and Tricks.

Request Remote Assistance

Run Teamviewer for quick support or request remote assistance.

Requesting Remote Assistance will allow Communicare Support to have alive view of your screen so we can
help you better.

To run remote assistance, when instructed by Communicare Support, in Communicare, select Help > Request
Remote Assistance.

In order to invoke Request Remote Assistance, on your keyboard, press CTRL+F2.
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Glossary

Glossary

Active medication

For prescribed regular medications, medications that are not expired, stopped or deleted.

Administer

The act of applying a medication directly to a patient. For example, when a nurse gives a patient an
injection.

Administrative Encounter Place

A group of encounter places defined for administrative or reporting purposes.

AIR Encounter

A visit to avaccination provider where one or more episodes (vaccines) are administered to the patient.

AIR Episode

The actual immunisation provided to the patient, by the vaccination provider. An AIR Encounter must
have a minimum of one episode, and a maximum of five episodes.

Biographics

General information about a patient, such as names, addresses, Medicare Number, and so on.

Class

A group of clinical item types that have common properties and attributes or data val ues.

Clinical item
A record of any event on a patient record, either actual or a planned recall, such as a disease,

immunisation, procedure, medication prescribed, and so on. Clinical Itemsin Communicare are coded
according to ICPC-2 PLUS.

Clinical item keywords

Specific words that can be used to locate Clinical Item types.

Consolidated order

Groups of medication requests used to order medications from an external pharmacy and to manage
patient-specific inventory.
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DAA

Dose Administration Aid (DAA) isthe term used for packaging that organises doses of medication
according to when they should be taken.

Dataset

A collection of related clinical item types, qualifiers and recall types.

Encounter

A meeting between a health provider and a patient.

Encounter mode

Either the means of delivering a health service, for example Telephone; or the type of physical place at
which a health serviceis delivered, for example, School.

Encounter place

Either a Service Encounter Place, where patient contacts occur; or an Administrative Encounter Place,
a concept that defines a group of encounter places for administrative or reporting purposes. The Service
Encounter Place isthe physical place at which a serviceisdelivered, or the physical place from which a
serviceis delivered, for example, Millennium Health Service Clinic. Each placeis categorised into one
or more Modes.

Episode
When a condition is diagnosed it may be classified as a FIRST, NEW, or ONGOING episode.

Health Centre Prescribing

Health Centre Prescribing (HCP) or Rural Prescribing is aworkflow used in the NT, where instead of
PBS scripts, asingle consolidated script is printed for all regular medications for a patient.

| mmunisation Provider

The provider who administered avaccine to an individual.

L ast consolidated order date

For the encounter place, the most recent date at which a consolidated order was ordered.

LEMI

From Active Ingredient Prescribing legislation, alist of excluded medicinal items (LEMI) for which
Communicare does not include the generic components. The LEMI includes non-medicinal items such
as bandages, or medications with four or more active ingredients.
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LMBC

From Active Ingredient Prescribing legislation, alist of medicines for brand consideration (LMBC),
for which providers should consider prescribing by brand. For example, medications that are not
bioequivalent.

Locality

A list of places used in patient addresses. Initial localities are taken from Australia Post localities, but
additional localities may be defined, for example, for alocal community.

Locality group

Where several localities are combined for reporting purposes. For example, Northern Region, South of
River, Inner City, and so on.

Medication request

M edi cation requests combine a patient's medications into a bulk-order prescription for sending to a
pharmacy for dispensing.

Medication summary

A list of apatient's currently active medications.

Mode

See Encounter mode (on page 76).

National Cancer Screening Register

Communicare integrates with the National Cancer Screening Register (NCSR).

Once off medication

A medication typically prescribed for acute clinical presentations, which the patient will take until
the course is complete. Once off medications are removed from the Medication Summary after their
duration has elapsed. Once off medications may also be described as Short Course medications.

Place

See Encounter place (on page 76).

Provider
Anyone who provides health care for a patient, such as a doctor, health worker, nurse, and so on.
Qualifier

A measurement associated with aClinical ltem
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Query

An instruction to retrieve statistics from the database.

Regular medication

A medication typically prescribed for a chronic disease, which the patient would be expected to take
continually. Regular medications are displayed on the Medication Summary until they are explicitly
stopped.

Report

The results of a query about datain the database.

Service recording

A record of a patient's services, such as clinic visits, home visits or other.

Supply
The act of providing medication to a patient or their carer.
Topic
A grouping of Clinical Itemsinto health or medical-related categories.

Vaccine Provider

A medical practitioner or person who is recognised by Services Australia as being a provider of
vaccinations to individuals, according to the Australian Immunisation Register Act 2015.

Walk-in patient

Patients who arrive without an appointment.
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